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  Photographic Illusions
Have you ever seen a photographic effect that you wanted to 
replicate? Dave Cross recently saw an image where the subject 
and other objects appeared to be floating in the air. He was soon 
in his studio shooting and processing images, creating his own 
version of this type of image. Dave walks us through his process, 
sharing what he learned along the way. 
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But Wait— There’s More

 Processing Trends
Brian Matiash and Nicole S. Young take a look at some of the 
hottest processing trends in the photography industry and show 
us quick-and-easy ways to re-create these effects in Photoshop. 
Soon, you’ll be the trendiest photographer in town, which will 
always make your clients happy.
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We had an amazing Photoshop World Conference last month, breaking last year’s attendance record, and by all accounts it was one 

of our best Photoshop Worlds ever, which is very gratifying on so many levels (we work really hard to make the event something truly 

special). However, at the same time, we ran into so many folks at the conference who still had no idea that NAPP and Kelby Training 

had joined forces to create KelbyOne, which is frustrating because it highlights the fact that we haven’t done a great job in getting 

that message out there.

It’s a message we’ve struggled with communicating since the two joined forces back in January, so in the next few issues you’ll see 

some of our new visual communications along these lines, including an education timeline in this issue (p. 99) that we hope will con-

vey our message that bringing these two together has created a better way to learn Photoshop, Lightroom, photography, and design.

When we were NAPP, we were focused on Photoshop and Lightroom, taught primarily through short video tutorials and articles 

on the member website. Our other company, Kelby Training, focused on world-class photography training. Now we’ve brought those 

two together, and we did it without raising the renewal price for existing NAPP members—it’s still, to this day, only $99 a year, as 

long as you don’t let your membership lapse (if it lapses, you have to then rejoin from scratch at the full membership rate, so in short, 

don’t let it lapse).

We’re in the midst of launching a new site, a new daily blog from The Photoshop Guys (myself included) at kelbyone.com/

blog, and an entirely new member experience. We really want our members to know about and take advantage of all our benefits. 

Although we’re primarily an in-depth online training resource, we back it up with an amazing magazine (you’re reading it); one-on-

one tech support on Photoshop, Lightroom, and camera gear; discounts on most everything you buy (even Apple gear straight from 

Apple); and all the latest techniques and tutorials from our team of the very best instructors.

I hope you’ll help us spread the word about how these two (NAPP and Kelby Training) have become “One,” and I hope you’ll take a 

few moments and check out our new online training experience, take advantage of those discounts, and keep reading Photoshop User 

magazine because we have some amazing stuff in each issue. Take this issue, for example. Our cover story from Brian Matiash and Nicole S.  

Young is on “Processing Trends: Quick-and-Easy Ways to Stylize Your Photographs.” They show us how to create a hand-tinted black-

and-white look, a split-toned retro look, photos with textures, and a lens flare effect all in Photoshop (p. 64).

Also in this issue, Matt Kloskowski presents “10 Things Aperture Users Need to Know about Lightroom” (p. 90). In our “Light 

It” column, Kevin Ames explains the difference between reflected and incident metering, and then shows us how to use an incident 

meter (p. 84). Dave Cross shows how he created a photographic illusion of his subject and other items being blown into the air by a 

speaker. He covers everything from the shoot to postprocessing (p. 112). In our “Photoshop Proving Ground” column, Scott Valen-

tine shows us some unique and artistic ways to use the Clone Stamp tool in Photoshop (p. 118), and Rob Sylvan teaches us how to 

speed up our workflow by taking advantage of templates in Lightroom (p. 100). Plus, all of your other favorites articles are here, too, 

like “Down & Dirty Tricks,” news, and reviews.

Thanks for all your support throughout this transition to KelbyOne. We’ve had so many people out there helping us spread the 

word, saying wonderful things on social media, and sending personal notes of gratitude, which is so incredibly awesome—we really 

value or members and appreciate your kind words more than you know. 

 

All my best,

Scott Kelby

KelbyOne President & CEO

Editor & Publisher, Photoshop User

From the Editor
 better benefits

A  F E W  W O R D S  F R O M  ›  ›  S C O T T  K E L B Y
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creates photographs for clients such as Westin Hotels, AT&T, and Coca-Cola. He  

has authored four books, including a Dummies book, and his photos have appeared in Time, 
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group of corporate clients. His latest book is Photoshop CC for Dummies. He was  
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in-box training, and is an instructor at Sessions.edu. His clients include Time Inc., 
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is an education and curriculum developer and website overseer for KelbyOne. He  
is one of the Photoshop Guys and co-hosts Photoshop User TV. With a fine arts  
background, Pete is well versed in photography, graphic design, and illustration.

MICHAEL CORSENTINO 
is an award-winning wedding and portrait photographer, Photoshop and Lightroom expert, 
author, columnist for Shutter Magazine and Resource Magazine, and speaker and interna-

tional workshop leader. Learn more at www.michaelcorsentino.com. 

DAVE CROSS 
has been helping people get the most out of their Adobe software for 25 years.  

Dave has a bachelor of education degree, is an Adobe Certified Instructor, and is  
in the Photoshop Hall of Fame.
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is the co-author of Photoshop Masking & Compositing, Real World Digital  

Photography, and The Creative Digital Darkroom. He leads workshops on digital 
photography, Photoshop, and Lightroom (SeanDuggan.com).
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is an author, freelance writer, presenter/trainer, and consultant with more than  
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is a freelance consultant in the Seattle area. He has worked as a graphic designer,  

an art director, and a creative director. For more information about Paul, visit  
http://about.me/paulhebron.

MATT KLOSKOWSKI 
is a full-time education director for KelbyOne and a Tampa-based photographer.  

He’s a best-selling author, and teaches Photoshop and Lightroom seminars  
around the world. 

BRIAN MATIASH 
is a published photographer, writer, and Googler. When not out photographing,  
he leverages his industry experience to help grow the Google+ Photos platform  
and community.

SCOTT ONSTOTT 
is the creator of Photoshop for Architects: CC Edition and author of Enhancing Architectural  
Drawings and Models with Photoshop, Taking Measure (secretsinplainsight.com),  
and other books and videos. See what he’s up to at ScottOnstott.com.

COLIN SMITH 
is an award-winning digital artist, photographer, and lecturer who has authored 18 books  
and has created a series of training videos. Colin is also the founder of the online resource  
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SCOTT VALENTINE 
is an Adobe Community Professional and Photoshop author. His latest book  
is The Hidden Power of Adjustment Layers (Adobe Press). Keep up with him  
at scoxel.com.

ERIK VLIETINCK 
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is a writer and editor who lives in San Francisco. He’s been covering the intersection  
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NICOLE S. YOUNG 
lives in Portland, Oregon, and specializes in landscape, travel, and food photography.  
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Photoshop User 
Magazine
Photoshop User magazine is the official publication of 
KelbyOne. It is for members and is not available to the 
public by subscription.

As a KelbyOne member, you automatically receive  
Photoshop User delivered right to your door (or digi-
tally) ten times a year. Each issue features in-depth 
Photoshop, Lightroom, and photography tutorials writ-
ten by the most talented designers, photographers, and 
leading authors in the industry.

KELBYONE 
is the world’s leading resource for Adobe® Photoshop®, Lightroom®, and 

photography training, news, and education. Founded in 1998 as the National 
Association of Photoshop Professionals (NAPP), KelbyOne has evolved from 

NAPP and KelbyTraining to create a singular hub for creative people to learn, grow, 
and inspire. From photographers to graphic designers, beginners to professionals, 

KelbyOne is open to everyone.    

There’s no faster, easier, and more affordable way to get really good at Photoshop 
and photography. You can join for only $25 per month or $249 U.S. for a full year 

of training. To learn more, visit www.kelbyone.com.

 

	

PHOTOSHOP USER MAGAZINE 
Ten issues of the best Photoshop tutorial-based magazine in the industry.  

MEMBERS-ONLY WEBSITE 
Our extensive website features time- and money-saving content.

ONLINE CLASSES & EDUCATION 
Thousands of Photoshop and photography tutorials, full online classes, and 

quick-tip videos. 

MEMBER DISCOUNTS 
Save anywhere from 2–4 times your membership cost by using our many 
industry-related discounts.

TECH SUPPORT 
Fast, friendly Photoshop, Lightroom, and photo gear help; equipment 
advice; and more from certified experts.

MEMBER COMMUNITY 
KelbyOne members range from beginners to pros and love to lend each 
other a hand. Together, we have built the friendliest, most knowledgeable 
Photoshop and photography community on the Web.

NEWS & REVIEWS 
Unbiased coverage on the latest equipment, plug-ins, and programs 
in the marketplace.

WEEKLY E-NEWSLETTER 
The KelbyOne Insider is your weekly connection to everything KelbyOne. It’s 
produced exclusively for members to keep you informed of everything new 
in the industry and at KelbyOne headquarters.

REGISTRATION DISCOUNT 
TO PHOTOSHOP WORLD 
CONFERENCE & EXPO 
The semiannual KelbyOne convention and the largest Photoshop and 
photography learning experience on the planet. It’s an amazing event.

FIND KELBYONE MEMBERSHIP DETAILS AT kelbyone.com or call 800-738-8513 Monday–Friday, 9:00 a.m. to 5:30 p.m. EST.

About KelbyOne

Member Benefits

and.one
www.kelbyone.com
kelbyone.com
http://www.zenfolio.com/z/promo/photo-books
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Warbirds 
world premiere
Recently, we rolled out the red carpet for our first-ever movie premier. Aviation 

Photography: Warbirds and the Men Who Flew Them from renowned avia-

tion photographer, Moose Peterson, debuted with an outstanding viewer-

ship. It goes down as one of the most creative things we’ve ever done here at 

KelbyOne. The idea started as a class, then morphed into a documentary, and 

then grew into a featured film. 

During the premier, Scott Kelby and Moose took us through this 

exhilarating film of World War II pilots and the planes they loved and 

flew. For Moose (and surely for all of us), this story is bigger than the 

images captured, and that’s exactly why this film was produced. He set 

out with the goal to not just take amazing photos, but to tell an equally 

as amazing story. Re-creating aerial battles of WWII, while challeng-

ing, was an essential piece of that storytelling process. Viewers were 

able to experience first-hand the power and brilliance of these planes, 

accompanied by personal and passionate interviews with navigators, 

gunners, pilots, and Tuskegee Airmen. 

As Moose superfans, this film allowed us to truly explore the depths of 

his passion for photography, and how he pours that passion into stunning images. This was certainly a night to remember. While 

it was a one-night-only, free event, members can enjoy this featured film anytime as an available course at http://kelbyone.com/

course/moose_warbirds. 

It’s a Wrap on 
photoshop world 2014
If you missed Photoshop World Vegas, you missed an incredible week! We had a ton of new instructors, new classes, and a wild 

week of creatives on the loose in our favorite spot, Las Vegas. 

Attendees arrived from all over the country (and out of country, too) to take part in the three-day, life-changing, career-making, 

educational event of the year. People from all walks of life, from students to professionals, hobbyists to enthusiasts, participated in 

more than 100 classes through eight different learning tracks. 

The conference kicked off with the ever-entertaining opening keynote, along with the fan-favor-

ite themed video featuring a swashbuckling performance by Scott Kelby and his faithful crew. The 

true award-winning moments came during our recognition of our Guru Award winners and the 

inductees of the Photoshop Hall of Fame. This year’s inductees include Adobe’s Principal Scientist, 

Russell Williams, and Kelby Media Group’s Creative Director, Felix Nelson. These moments allow 

us to praise the creative work of the individuals we teach, along with 

highlighting professionals who continue to use Adobe in amazing ways. 

As classes kicked off, the halls of Mandalay Bay were bubbling with 

excitement. This is what makes Photoshop World unlike any other con-

ference. The ability to network in and out of class, to brush shoulders 

with your photography idols, to relish in the camaraderie of like-minded 

creatives is all part of the journey that seems to get better each year. 

As we close the chapter on Photoshop World 2014, hang up our party 

hats, and return our pirate costumes (okay, maybe we’ll keep those), we 

hope that if you attended, you enjoyed your experiences and are putting 

to practice the tools you acquired. If you missed the chance, we hope to 

see you in 2015, when the world’s largest creative stage gets even bigger.

ARTIST SPOTLIGHT ›  ›  JOE HUDSPETH 
MEMBER SINCE 2012 | WWW.JHUDPHOTOGRAPHY.COM

ARTIST SPOTLIGHT ›  ›  TIMOTHY DENEHY 
MEMBER SINCE 2014 | WWW.TIMOTHYDENEHY.COM

ARTIST SPOTLIGHT ›  ›  KELLY EDWARDS 
CLIENT WORK |  
HTTP://KELLYEDWARDSPHOTOGRAPHY.ZENFOLIO.COM

ARTIST SPOTLIGHT ›  ›  PATRICE MICHELLON 
MEMBER SINCE 2011 | WWW.PATRICEMICHELLON.COM
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ARTIST SPOTLIGHT ›  ›  FRANK EMIL 
MEMBER SINCE 2013 | WWW.FRANKEMIL.COM

ARTIST SPOTLIGHT ›  ›  ALEKSANDAR MITIC 
WWW.ALEXANDAR.CH

“@MoosePeterson Watching your #KelbyOne 
Black & White course and I simply love your 
energy. I just want to stop it and get out 
there.”—@Patrick_leger

“Just watched @KelbyOne @MoosePeterson 
Warbirds and the Men Who Flew Them. 
Wasn’t what I expected. It was so much 
more. Loved it!”—@stevetrup

“My first car shoot—I learned a lot from  
@Ambient_life and @KelbyOne. Thanks  
for sharing your techniques!” 
 —@alexscottphotog 

“@MyPSWorld discovering the awesomeness 
of @robertophoto. Learned a lot from him; 
very inspired. Great addition to PSW!” 
 —@BillSparksPhoto

Trailblazers: Powerful Women 
of photography
What does it take to stand shoulder to shoulder with soldiers on enemy 

soil and reach for a camera when they reach for a weapon, or brave 

temperatures of 40° below through four winters to fully understand 

the subjects in front of your lens? Why risk your life to capture images 

of an issue so violent and dangerous that each frame you take could 

be your last?

Amazingly, there’s no shortage of women tackling these assign-

ments. In the new KelbyOne interview series Trailblazers: Powerful 

Women of Photography, hosted by Mia McCormick, you’ll meet the 

only female photographer in the nation for Getty Images sports wire. 

You’ll also meet a woman who brought us honest images of combat 

from the front lines of two wars, and many others with incredible sto-

ries of sheer will to capture images with impact. Mia spent months 

researching the women whose dedication to their craft continuously 

takes them beyond the beaten path. They’re blazing new trails, bring-

ing us images that took tremendous bravery, inner confidence, and 

keen eyes to deliver.

These women are changing the way females are viewed in this 

industry. They’ve created powerful work while often overcoming 

the mindsets of a male-dominated genre; taking on dangerous, life-

changing assignments; or surviving Mother Nature in the rawest sense. 

Each month, a new group of not-so-average ladies will sit down 

with Mia and inspire the fire in all of us. You can view this unique and 

inspiring series at http://kelbyone.com/trailblazers. 

WWW.FRANKEMIL.COM
WWW.ALEXANDAR.CH
http://kelbyone.com/trailblazers
https://keepsnap.com
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Who's Who 
	 in the kelbyone community

Want to know what it takes to be a Photoshop World 

Guru Award Best in Show winner? Then say hello to Patrick 

LaMontagne. A five-year alumnus, this self-syndicated edi-

torial cartoonist, illustrator, and digital painter just nabbed 

our Best in Show award in Las Vegas for his One in Every 

Family painting. Read on to learn more about his award-

winning style.

Tell us a little about the inspiration behind One in 

Every Family. 

This painting was inspired by a real family of great horned 

owls that I discovered locally on one of my regular mountain 

hikes. After multiple visits, many photos, and some sketch 

paintings, and from observing their real behavior, this paint-

ing became inevitable.

How has Photoshop World helped you reach your goals?  

While I’ve learned a lot from the classes and instruction over 

the years, the connections I’ve made have been invaluable. 

I’ve made lasting friendships with other creatives who inspire 

and assist me in my work. Sometimes it’s just offering a cri-

tique or opinion, but when I require reference photos from 

time to time, many of those have come from photographers  

I know from the Photoshop World community. 

What’s the best tidbit of advice you’ve received as  

an artist?  

Learn from everybody. Copy nobody. Find your own style. 

You’re headed to an island and can only be armed with 

three items. What are they? 

Well, if it wasn’t a survival situation and I had power, I’d 

bring my sketchbook, camera, and my iPad to catch up on 

magazines and books. 

Name another proud moment in your career. 

The thing I’m proudest of is that I started late in this profes-

sion and didn’t go to art school. I didn’t do any paid work 

until my late twenties and didn’t start doing it full-time until 

I was 35. When you’re a teenager, it’s easy to take these 

risks. When you have a wife and a mortgage, it’s a lot more 

frightening, but very gratifying when it pays off. It’s never too 

late to follow a dream. 

If you could be any fictional character, who would  

you choose?  

If you want to get existential, we’re all fictional characters. 

Spoken like a true artist. Keep paving the creative path, 

Patrick. We’re right behind you! To see more of Patrick’s 

work, visit www.cartoonink.com. To see the rest of the 

Photoshop World Guru Award winners from Las Vegas 2014, 

turn to page 20. 
Patrick LaMontagne

Spread the
good word
Teaching is our passion. It’s in everything we do. Hearing your 

success validates the very reason why we’re here. So preach 

on about the good word. We’re all ears. 

“�Shout out to Photoshop Guy Pete Collins. I’ve been using 

the Clone Stamp for years, but his ‘Cloning & Healing Crash 

Course’ at KelbyOne revealed to me things I never knew it 

could do.”—Randy H.

“�Oohhh, loving this new KelbyOne class ‘Hacking Photoshop’ 

by Ben Willmore! I’m only part of the ways through  

it and have to leave the house now, but I’ll be back!” 

—Allison C.

“�I would have never been able to make shots like this if it were 

not for my Kelby training. A friend of mine challenged me 

to take a photo of the super moon in Waco and said bring 

a wide lens. I thought he was nuts and brought a 150–500. 

I showed him, but it took four shots! Thanks to all of the 

Photoshop trainers!”—Ken L.

“�This was my first Photoshop World and I won the ticket to 

attend via KelbyOne. The classes were excellent, sometimes jaw-

dropping (Bert Monroy), and inspiring. The attendees and staff 

were all very friendly and helpful. I did not have one bad experi-

ence during the whole trip. I can’t thank you enough KelbyOne 

for the ticket and the experience. You made a convert out of me 

and I will see you next year in Vegas!”—June C. ■

www.cartoonink.com
http://www.tamron-usa.com
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Congratulations to all the 2014 Photoshop 
World, LasVegas, Guru Award Winners!BEST OF SHOW  

PATRICK LAMONTAGNE

COMMERCIAL
MIKE CAMPAU

AWARDSGURU
KelbyOne is proud to announce the winners of the West Coast 2014 Guru Awards. The winners in nine categories, 
including the Best of Show, were revealed during the opening keynote of KelbyOne’s semiannual convention, 
Photoshop World, in Las Vegas. Sponsored by B&H (www.bhphotovideo.com), the ceremony featured images and 
photography from international entries in a wide variety of styles, techniques, and skill levels.

ARTISTIC
JAMES WESLEY TAYLOR
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BROOKE FIGER
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PHOTO RESTORATION
SHERI HARVEY

PHOTO MONTAGE
DOMINIK KOKOCINSKI

PHOTOGRAPHY
KOBI GULIANNI RETOUCHING

ROCKY MONTEZ-CARR

VINCENT VERSACE AWARD
for Excellence in Digital Photography
DEB USCILKA

THE FINALISTS  
ARTISTIC 
Jamie Carroll, Paul Jacklitch 
 
COMMERCIAL 
Mike Colahan, William Manchas 
 
ILLUSTRATION 
Russell Hombo, Patrick LaMontagne 
 
PHOTO MONTAGE 
Mike Campau, Jamie Carroll 
 
PHOTO RESTORATION 
Annette Berglund, Joe Lapinski 
 
PHOTOGRAPHY 
Regina Pagles, Christine Pentecost

RETOUCHING 
Paul Bartell, Megan Kelly



http://www.mpixpro.com
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By mike mackenzie and chris main

Canon Unveils Speedy EOS 7D Mark II  
and powershot cameras
Canon U.S.A., Inc. pulled the wraps off the new EOS 7D Mark II and three PowerShot cameras: the G7 X, SX60 HS, and N2. 

The Canon EOS 7D Mark II sports a 20.2-megapixel CMOS (APS-C) sensor and dual DIGIC 6 Image Processors for 

increased speed and to reduce chromatic aberration, variances in peripheral illumination, and lens distortion. The 65-point 

cross-type AF system provides accurate subject tracking, and shooting up to 10 frames per second ensures you’ll capture 

the action. Other features include an ISO range from 100–16,000, expandable to 51,600; a 3", 1,040K-dot Clear View II 

LCD; built-in GPS with digital compass; dual card slots for SD/SDHC/SDXC and CF memory cards; a built-in intervalometer 

and bulb timer (EOS DSLR firsts); and rugged magnesium-alloy body.

For those who shoot video, the EOS 7D Mark II captures Full HD 1920x1080 resolution at 60/30/24p, and at ISO 

values up to 16,000. Movie Servo AF allows you to define the AF location and speed and tracking intervals for smooth 

focus transitions.

Canon also announced the PowerShot G7 X, PowerShot SX60 HS, and PowerShot N2 cameras. The PowerShot G7 X is 

Canon’s first compact camera with a 1" sensor. The 20.2-megapixel G7 X uses the DIGIC 6 Image Processor and has an ISO 

range of 125–12,800. Features include a 4.2x optical zoom ratio (equivalent to 24–100mm), f/1.8 to f/2.8 lens from wide 

to telephoto; Intelligent IS that optimizes image stabilization; a multiangle 3", 1,040K-dot LCD; built-in Wi-Fi; RAW capture; 

31-point AF; shooting speeds up to 6.5 frames per second; and Creative Shot Mode that allows you to add filters to your 

still photos. When you need to shoot video, the G7 X captures Full HD video at up to 1080/60p.

The PowerShot SX60 HS has a whopping 65x optical zoom (equivalent to 21–1365mm) with Optical Image Stabilization, 

and includes a 16.1-megapixel CMOS sensor; DIGIC 6 Image Processor; 3", 922K-dot Vari-Angle LCD; 1080/60p Full HD 

video capture; and built-in Wi-Fi. When shooting at extreme telephoto focal lengths, the Zoom Framing Assist function 

remembers the previous zoom position, zooms out to locate the subject, and zooms back to the saved position when the 

button is released.

	 The compact N2 has an 8x optical zoom lens (equivalent to 28–224mm) with Intelligent IS. It uses a 16.1-megapixel 

CMOS sensor, DIGIC 6 Image Processor, and it features a 2.8", 180° tilt, touchscreen LCD. Also included are built-in Wi-Fi 

and Full HD video capture.

	 The Canon EOS 7D Mark II will be available in November for $1,799 (body only), or it can be bundled with the EF-S 

18–135mm f/3.5–5.6 IS STM lens for $2,149. The PowerShot G7 X should be available now and costs $699.99. Also avail-

able now is the PowerShot SX60 HS, which goes for $549.99. The PowerShot N2 will be available in December for $299.99. 

For more information, visit http://usa.canon.com.

 ›  ›  e x p o s e d :  i n d u st r y  n e w s

Nikon Releases New DSLR,    
	 wide-angle lens, and speedlight

In September, Nikon Inc. announced a new FX-format DSLR, the D750, 

along with the AF-S NIKKOR 20mm f/1.8G ED wide-angle lens and the 

SB-500 Speedlight.

According to Nikon, “The new D750 represents a leap forward for 

this camera segment, inheriting some of the best elements from Nikon’s 

revered full-frame professional cameras.” The 24.3-megapixel Nikon 

D750 uses a CMOS sensor and the same EXPEED 4 Image Processing 

Engine found in the D810 and D4S. Features include Nikon’s 

advanced 51-point AF system; Advanced Multi-Cam 3500-FX II AF 

focus system that tracks fast-moving subjects; 15 cross-type AF sen-

sors; and a high-speed burst rate of 6.5 frames per second. With an 

ISO range from 100–12,800, expandable to 50–51,200, you’ll be 

able to make great photos in any shooting environment.

The D750 isn’t for still photos only, as it allows for video capture 

to dual SD cards in Full HD 1920x1080 resolution at 60/30/24p 

with full manual control, including aperture adjustment. A 3.2", 

1,229K-dot Vari-Angle LCD ensures you can shoot photos or video 

from overhead, waist level, or on a tripod. When you’ve captured 

the moment, share it with clients, friends, or family via the built-in Wi-Fi. 

Accompanying the D750 release is the wide-angle AF-S NIKKOR 

20mm f/1.8G ED FX-format lens. This is Nikon’s first ultra wide-angle lens 

with an f/1.8 aperture. It has a 94° angle of view, making it ideal for wide-

angle landscape, architecture, and interior shots. In addition to quiet and 

fast autofocus and an internal focus design, the lens also features Nikon’s 

Nano Crystal Coat to reduce lens flare and ghosting.

Rounding out Nikon’s September announcement is the SB-500 

Speedlight. What sets this flash apart is it’s also an LED video light. This 

SB-500 covers a wide 16mm, has a 90° vertical swivel, and a 180° rotation. 

While the controls are simplified, it can still be integrated into a CLS system 

with two-group, two-channel control. It’s powered by two AA batteries to 

reduce size and weight.

	 All three products are available now. The D750 sells for $2,299.95 

(body only); the AF-S NIKKOR 20mm f/1.8G ED lens goes for $799.95; 

and the SB-500 Speedlight costs $249.95. For more information, visit 

www.nikonusa.com. 

Topaz Impression
 turns photos into art
Topaz Labs recently released Topaz Impression, a stand-alone app or Photoshop and Lightroom plug-in that transforms photos 

into digital paintings by applying brushstrokes. 

According to Topaz, “Impression helps make your photos more expressive by authentically turning them into art, the way 

a real artist would.” This means you prepare the canvas for your project, build your brush, select the color palette, and let 

Impression apply the individual brushstrokes in seconds. Nearly every aspect of the process is customizable, and you can modify 

your brush, color palette, and canvas in real time.

Topaz Impression is available now for $99.99, and there’s a free trial. For more information or to purchase, visit 

www.topazlabs.com.

Exp  sed: Industry News
The latest news about photography gear, software, and services›  ›

http://usa.canon.com
www.nikonusa.com
www.topazlabs.com
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 ›  ›  e x p o s e d :  i n d u st r y  n e w s

Blackmagic Design Makes a 
	 plethora of announcements

Blackmagic Design creates everything from digital film 

cameras to video editing products for the feature film, 

postproduction, and television broadcast industries. 

At IBC2014 in September, they hit us with a flurry 

of hardware and software announcements. Here’s a 

quick rundown of what they released.

Their Blackmagic Production Camera 4K and 

Blackmagic Cinema Camera are now both available 

with PL lens mounts for using both professional and vintage 

lenses. The Cinema Camera is machined out of a solid block of aluminum, which means its small size is strong enough to 

handle an extremely heavy PL-mount lens and fit into tight locations. It features a large, high-resolution 2.5K-sized sensor 

with 13 stops of dynamic range. The Production Camera 4K has a large, high-resolution 4K Super 35mm-sized sensor with 

global shutter with 12 stops of dynamic range.

The new Blackmagic MultiView 16 is the world’s first native Ultra HD multiviewer that allows the use of the new large 

Ultra HD televisions and monitors for displaying images at twice the resolution of HD multiview. It supports the display of 

up to 16 mixed SD, HD, and Ultra HD video sources at the same time. Speaking of Ultra HD monitors, Blackmagic also 

announced the SmartView 4K, the world’s first full-resolution Ultra HD broadcast monitor with 12G-SDI inputs for compat-

ibility with virtually all SD, HD, and Ultra HD formats up to 2160p60. With a native resolution of 3840x2160, it includes both 

universal AC power as well as 12V DC power inputs so it can be used in just about any environment, including on location.

The Smart Videohub 40x40 is Blackmagic’s newest model in their family of mixed-format routers with their unique 

visual routing user interface and 6G-SDI technology, allowing SD, HD, and Ultra HD routing all at the same time. It includes 

a 5" built-in monitor and spin knob router control. They also announced the DeckLink 4K Extreme 12G, a new Dual Link 

12G-SDI capture and playback card that includes an extremely fast 8-lane PCI Express Generation 2 connection, allowing 

extremely high performance such as dual-stream video capture and playback at resolutions up to 2160p60. The new Ultra 

HD-compatible Mini Converters and Heavy Duty Mini Converter 4K models feature 6G-SDI technology, allowing customers 

to use a single type of converter for all SD, HD, and Ultra HD conversion needs.

In software news, Blackmagic announced Videohub Software Update 6, a whole new software suite for their popular 

Videohub range of SDI routers that provides new client control and setup applications for easier router operation. They’ve 

updated DaVinci Resolve to 11.1 with dozens of features and improvements that professional editors and colorists have 

been asking for. And finally, they announced the acquisition of eyeon Software, Inc., a leading developer of high-end digital 

compositing, visual effects, and motion graphics software, which includes Fusion 7.

As you can see, Blackmagic has been extremely busy. If you’d like to learn more about the pricing and availability of these 

and other Blackmagic products, visit www.blackmagicdesign.com. 

Phottix Makes Product 
announcements at photokina 
At Photokina in September, Phottix announced several new products for photographers and videographers. First up is the 

Phottix Odin II TTL Flash Trigger. This update to the original Odin includes five groups with a button for each group and a 

control dial for quickly adjusting flash power levels, 2.4 GHz frequency with a range of 100m, and 32 channels with Digital 

ID to prevent triggering by other nearby triggers. It also has TTL and manual power control, high-speed sync up to 1/8000, 

second curtain sync, flash zoom control, and an AF assist beam. The Odin II should be available in Q1 of 2015.

Phottix also unleashed the new Indra500 TTL Studio Light. This 500w light features TTL, Manual, and Stroboscopic 

modes; high-speed sync up to 1/8000; second curtain sync; TTL exposure adjustments in +/– 3 EV levels; and manual power 

from 1/128 to full power in 1/3 stops. It can be powered either by a battery pack or with the AC power adapter. At just 

more than 4.5 pounds, the Indra500 TTL was developed for on-location shoots and events, such as weddings. It comes with 

a built-in Odin receiver that works with Canon and Nikon, and a built-in Phottix Strato II Receiver that works with Strato II 

transmitters. When used with the Indra Battery Pack, photographers can take up to 340 full-power shots with two-second 

recycle times, as well as power two lights. An Indra500 TTL and Indra Battery Pack will retail for $1,295.

They also announced the Phottix VLED 168, 198, and 260 continuous lighting solutions for video cameras and DSLRs. 

The number represents the number of LEDs in each VLED. The 168 produces 1,050 lumens, the 198 1,250 lumens, and the 

260 1,600 lumens. They can be powered by six AA batteries or using the included battery adapters that work with camera 

batteries from Canon, Nikon, Panasonic, and Sony.

For more information on pricing and availability on these products and more, visit www.phottix.com. 

Perfect Photo Suite 9 Offers 
new features, enhancements
onOne Software announced Perfect Photo Suite 9, a collection of all seven of their applications: Perfect Browse, Perfect 

Enhance, Perfect Layers, Perfect Effects, Perfect B&W, Perfect Portrait, and Perfect Resize.

Perfect Photo Suite 9 sports a new preview mode that allows you to quickly sort, cull, rate, add keywords, and edit 

photos. Also new is Smart Photo, which allows you to reedit your photos with the previous setting intact after you save 

and close the file. Other new features include the Quick Mask tool, noise reduction, Lens Flare filter, auto tone, crop and 

level tools, print options, batch rename, and ratings and labels. While they were at it, onOne also improved the image 

processing and updated the Perfect Brush so it works better along soft edges and on semitransparent objects, such as 

smoke or hair.

Perfect Photo Suite 9 should be available in late October for $149.95 for a new license, or $99.95 to upgrade. For  

a comprehensive list of new features and improvements or to purchase, visit www.ononesoftware.com. ■

www.blackmagicdesign.com
www.phottix.com
www.ononesoftware.com
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This is one of the times you might find the 3D features in Photoshop 
useful in creating 3D effects. In this tutorial, we’re going to re-create 
the metallic text effect from the movie Maleficent. You’ll see how easy 
it is to employ 3D in Photoshop to create realistic effects.

maleficent text effect
B Y  C O R E Y  B A R K E R

Step One: Begin by opening the Malevolent_Start.psd download 

file. Go to the Paths panel (Window>Paths) and click the path 

containing the text shapes. If you prefer, you can create your 

own text and then convert it into a path by Right-clicking on the 

layer and choosing Create Work Path from the menu.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/november-2014. 

All files are for personal use only.]

Step Two: In the Layers panel, make a duplicate of the black 

Background layer by pressing Command-J (PC: Ctrl-J). Hide the 

Background layer for the moment by clicking its Eye icon.

Step Three: With the duplicate layer (Layer 1) and the path 

(Path 1) selected, choose 3D>New 3D Extrusion from Selected 

Path. Click Yes in the dialog that appears to switch to the 3D 

workspace. This converts the text into a 3D extrusion; however, 

the extrusion is a bit much.

Step Four: Go to the 3D panel 

(Window>3D) and locate Layer 1. 

Clicking the arrow to the left will 

reveal the materials and boundary 

constraints. With Layer 1 selected,  

go to the Properties panel (Window> 

Properties) and set the Extrusion 

Depth to 75 px. 

Step Five: Back in the 3D panel, 

click on the Environment property 

at the top of the list. Now jump over 

to the Properties panel again, go to 

the Ground Plane Shadow settings, 

and change the default 60% Opac-

ity shadow to 0% to get rid of the 

ground plane shadow. 

Step Six: Go back to the 3D panel and click on the main Layer 1  

item again. Back in the Properties panel, click on the third tab 

at the top to access the Cap settings. This is where you manage 

any bevels or inflation effects you have on your 3D object. In this 

case, we’re only interested in the Inflate section at the bottom. 

Set the Angle to 75° and the Strength to about 10%. This will 

bulge out the front face of the text, giving it a curved look. This 

increases the surface area and angle, which will give a lot more 

variation of the reflection we’re going to add later. 

Step One

Step Two

Step Three

Step Four Step Five

Step Six

Malevolent_Start.psd
http://kelbyone.com/magazine/issue/november
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Step Seven: In the 3D panel, 

click on the Layer 1 Front Inflation 

Material to select it. In the Proper-

ties panel you’ll see settings for the 

various surface materials. Go to 

the middle section where you see 

Shine and Reflection and set each 

to 100%, then set the Roughness to 

20%. This will soften the reflection 

so it’s not fully mirrored. 

Step Eight: Now we need to apply the texture that will be 

reflected in the surface of the text. We’re going to apply this as 

an image based light (IBL) so it will affect all surfaces. In the 3D 

panel, select the Environment property again, then return to the 

Properties panel, click on the icon next to the IBL thumbnail, and 

choose Replace Texture. Locate the abstract metal texture file 

that’s part of the download and click Open. 

The text will appear to have a metallic reflection. Click-and-

drag inside the document to reposition the reflection to get the 

look you want. Feel free to try other images as reflective IBL. You 

can use almost anything.

Step Nine: At the top of the 3D panel are the 3D object icons. 

Click the light bulb icon on the right to access the lights. You’ll 

see the default Infinite Light 1 just below the Environment. 

Click on it and jump over to the Properties panel. Now click on 

the Color swatch, choose a bright blue color in the Color Picker, 

and click OK. Set the Intensity to 300% in the Properties panel. 

To move the light around, 

switch to the Move tool (V), click 

the Rotate the 3D Object icon 

in the Options Bar (the first icon 

in the 3D Mode section), then 

click-and-drag on the canvas to 

change the angle of the light. We 

positioned ours (the blue circle) 

at the top over the center of the 

letter “L.” 

Step Ten: Now the text looks nice and polished, but we want 

to rough it up a bit, as if it has sustained some wear with 

little dents and such. We’ll achieve that through the use of a 

bump map. In the 3D panel, click the first icon at the top to 

see the whole scene, then click Layer 1 Front Inflation Mate-

rial to select it. You’ll need a file that contains a mild texture. 

I have a file of a simple concrete texture that I have increased 

the contrast on so there are some random dark spots on a 

mostly white background. Go to the Properties panel, click the 

folder icon to the right of the Bump setting, and choose Load 

Texture. Locate the bump texture and click Open. If the bumps 

seem extreme, lower the default 10% Bump setting down to 

around 3%.

Step Eleven: Reselect the main 

Layer 1 item in the 3D panel, then 

choose 3D>Split Extrusion. Click 

OK in the warning dialog. This 

will break up the individual letters 

so you can manipulate each letter 

individually. What we want to do 

here is select the left side of the M 

by clicking directly on it with the 

Move tool (V). Then click on the 

red arrowhead and drag it to the right until the objects intersect. 

Now click on the blue arrow, which is pointing right at you, and 

drag down slightly to bring the object forward a bit so that one 

object appears to be in front of the other instead of intersecting. 

Step Twelve: Choose 3D>Render and let the render finish, bar-

ring any last-minute adjustments you want to make. When the 

render is done, click the Add a Layer Style icon (ƒx) at the bot-

tom of the Layers panel, and 

choose Gradient Overlay from 

the list. Click on the Gradient 

thumbnail and in the Gradient 

Editor dialog, double-click the 

white color stop below the 

gradient ramp on the right. In 

the Color Picker that appears, 

choose a deep blue color like 

the one shown here. Click OK 

to close the Color Picker, and 

click OK again to close the 

Gradient Editor. Step Nine
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Step Thirteen: Back in the Layer Style dialog, change the Blend 

Mode to Soft Light, drop the Scale to around 70%, and click OK. 

This will add an enhanced color effect on the 3D object, which is 

changeable at any time as long as it remains a layer style. 

Step Fourteen: Of course, you simply can’t have metallic text and 

not have some flares. Double-click the custom brush that’s part 

of this exercise’s download to load it into Photoshop. Switch to 

the Brush tool (B), go to the Brush Presets panel (Window>Brush 

Presets), and locate the brush at the bottom of the list. Click 

the Create a New Layer icon at the bottom of the Layers panel, 

and press D then X to set the Foreground color to white. Now 

click in different areas to paint a few flares on the text. Use the 

Bracket keys to quickly change the size of your brush. Next, we’ll 

enhance the overall coolness 

of the flares. Click the Add a 

Layer Style icon and choose 

Outer Glow. Click the color 

swatch, choose a blue color 

similar to the one we used in 

the previous step, and click 

OK. Change the Blend Mode 

to Hard Light, and drop the 

Opacity to around 50%.

I finished the atmosphere of the scene with some colorized fire 

elements to complete the overall look. While the finished design 

is front facing with 3D metallic effects, we still have the option 

of rotating the entire name in 3D space at pretty much any angle 

we want; 3D is much more flexible than you might think. You 

have to dig in and see what’s possible. ■ 

Final

Step Fourteen

Step Thirteen

http://macphun.com/kelby


H O W  T O  › › › › D O W N  A N D  D I R T Y  T R I C K S

› 
› 

k
e

l
b

y
o

n
e

.c
o

m

039

&
Down

Dirty
Tricks

Several years ago, a co-worker turned me onto the science fic-
tion subgenre known as steampunk while discussing ideas for 
a marketing campaign. The idea was never approved but the 
steam-driven, Victorian-era imagery stuck with me. I immedi-
ately tried to incorporate retro-mechanical elements into other 
design projects that also never got off the ground. But last 
issue’s 100 Photoshop tips cover design finally gave me the 
opportunity to release my inner Jules Verne (thanks, Nancy). 

steampunk-style type effect, part one
B Y  F E L I X  N E L S O N
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Shown with Layer 1  
Opacity set to 50%

In part one of this tutorial, we'll focus on how we created the base 

and beveled edges on the number 1. You’ll use the same tech-

niques to produce the edges of the other numbers individually. 

We used lots of screwheads, gears, bolts, antique dials, vacuum 

tubes, brass piping, and metallic background images to create 

the mechanical interior portions, but we’ll cover that in part two.

[KelbyOne members may download the files used in this 

tutorial at http://kelbyone.com/magazine/issue/november- 

2014. All files are for personal use only.]

Step One: Create a new 3.5x5" document at 212 ppi. Choose 

the Type tool (T) from the Toolbox, and press D to set your Fore-

ground color to black. Using Fette Fraktur LT Std Regular for the 

font at 412 points (any bold serif font will work), click in the 

center of the document and enter the number 1. Click the Add 

a Layer Style icon (ƒx) at the bottom of the Layers panel, and 

choose Outer Glow. Choose Multiply as the Blend Mode, click 

on the yellow color swatch, select black as the color, and click 

OK to close the Color Picker. Enter 40 px for Size and click OK to 

apply the layer style.

Step Two: Open a metallic back-

ground image (a brass plate with 

screws in our example). Using the 

Move tool (V), click-and-drag the 

texture into the document you 

created in Step One and position 

it over the number 1. This will 

add a new layer (Layer 1). If nec-

essary, press Command-T (PC: 

Ctrl-T) for Free Transform, and 

resize the texture to cover the number 1. Press Enter to commit 

the transformation.

Step Three: With Layer 1 still highlighted as the active layer, 

Command-click (PC: Ctrl-click) on the layer thumbnail next to 

your type layer in the Layers panel to create a selection. Go to 

Select>Modify>Contract. Enter 15 pixels and click OK. Now, go 

to the bottom of the Layers panel and click on the Add Layer 

Mask icon (circle in a square).

Step Four: Click on the Add a Layer Style icon, choose Bevel & 

Emboss, and select Inner Bevel for Style. Enter 100% for Depth, 

25 px for Size, and 7 px for Soften. Select Multiply as the High-

light Mode, and lower the Highlight Mode Opacity to 50%. Click 

on the white color swatch, choose a light-brown color (R:114, 

G:79, B:19), and click OK. Now, click on the black color swatch, 

choose the same light-brown color as you did for the Highlight 

Mode, and click OK. Lower the Shadow Mode Opacity to 50%. 

Don’t click OK yet to apply the layer style.

http://kelbyone.com/magazine/issue/november
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Step Five: Click on the words “Inner Glow” in the list of Styles 

on the left side of the Layer Style dialog. Choose Multiply as the 

Blend Mode, and enter 100% for Opacity. Click on the yellow 

color swatch, choose a dark-brown color (R:64, G:36, B:10), and 

click OK. Enter 10% for Choke and 20 px for Size. Click OK to 

apply the layer styles.

 

Step Six: Go back to the metallic background image you used 

in Step Two (the brass plate with screws in our example). Press 

Command-U (PC: Ctrl-U) to bring up the Hue/Saturation dialog. 

Enter –19 for Hue, –70 for Saturation, and –21 for Lightness, and 

click OK. Click-and-drag it into the current document (Layer 2),  

and use Free Transform to resize it to cover the number 1. Com-

mand-click (PC: Ctrl-click) on the type layer’s thumbnail to load 

it as a selection. Click on the Add Layer Mask icon at the bottom 

of the Layers panel.

Step Seven: Command-click (PC: Ctrl-click) directly on the layer 

mask thumbnail on Layer 1 to load it as a selection. Then, press 

Option-Delete (PC: Alt-Backspace) to fill the selection with black, 

knocking out the center portion of the layer mask on Layer 2. 

Press Command-D (PC: Ctrl-D) to deselect.

Step Eight: With Layer 2 highlighted as the active layer, click 

on the Add a Layer Style icon at the bottom of the Layers panel, 

and choose Bevel & Emboss. Enter 200% for Depth, click on the 

down-facing arrow next to the Gloss Contour thumbnail, and 

choose Ring. Choose Overlay as the Highlight Mode, click the 

white color swatch, choose a gray color (R:220, G:220, B:220), 

and click OK. Choose Overlay for the Shadow Mode, and lower 

the Opacity to 50%. Don’t click OK yet.

Step Nine: Choose Gradient Overlay from the Styles list on the 

left side of the Layer Style dialog. Choose Overlay as the Blend 

Mode, and change the Opacity to 80%. Click on the Gradient 

thumbnail. When the Gradient Editor dialog appears, choose 

the Foreground to Transparent preset (second from the left). 

Double-click the black color stop below the gradient ramp, 

choose an orange-yellow color (R:244, G:198, G:96), and click 

OK to close the Color Picker. Click OK again to close the Gradi-

ent Editor. Enter 90º for Angle, 25% for Scale, and click OK to 

apply the layer style.

Note: The orange gradient is meant to mimic a reflective color 

from a fire or a glowing heat source in our example. You can 

edit the gradient color or eliminate it altogether.

Step Ten: Open an image of screwheads or boltheads. Using the 

Elliptical Marquee tool (nested under the Rectangular Marquee 

tool [M] in the Toolbox), make a selection of a single screwhead. 

Using the Move tool, click-and-drag your selection into your 

original document (Layer 3). Press Command-Shift-U (PC: Ctrl-

Shift-U) to desaturate the color.

Step Eleven: Press Command-T (PC: Ctrl-T) to bring up the Free 

Transform bounding box. While holding down the Shift key to 

constrain the selection, click-and-drag one of the corner adjust-

ment points toward the center to resize the screwhead. Once 

you’ve resized the screw, click in the center of the Free Transform 

Bounding box, and drag it over the beveled edge we created. 

You may need to resize the screwhead slightly if it doesn’t fit 

within the edge. Press Enter to apply the transformation. 

Step Twelve: Click on the Add a Layer Style icon and choose 

Inner Glow. Choose Multiply as the Blend Mode, and click the 

yellow color swatch. Choose black as the color and click OK. 

Don’t click OK in the Layer Style dialog yet.
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Step Thirteen: Now, choose Outer Glow from the Styles list. 

Choose Multiply as the Blend Mode, and click on the yellow 

color swatch. Choose black as the color and click OK. Enter 5% 

for Spread and 5 px for Size. Click OK to apply the layer styles. 

 

 

Step Fourteen: Command-click (PC: Ctrl-click) on the Layer 3 

thumbnail to load it as a selection. While pressing-and-holding 

the Option (PC: Alt) key, click-and-drag the selection to duplicate 

and move it to another area of the edge (see example). Repeat as 

many times as necessary until the screwheads appear to secure 

the gray edge to its brass base.

Note: You may want to slightly rotate each of the screwheads 

so they don’t appear to be exact duplicates.

Step Fifteen: To add the same 

Gradient Overlay layer style that’s 

used on Layer 2 to the screw-

heads, press down the Option 

(PC: Alt) key while you click-and-

drag the words “Gradient Over-

lay” (under Layer 2) to just below 

Layer 3. ■ 

We’ve added a background so the effects 
are viewed as intended in the final image 

http://profoto.com/us/b1
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Dirty
Tricks

They are among us, and they have the power to destroy us. It’s 
up to you to save mankind! Okay, that may be overstating it a 
bit, but here’s a technique to really make your text shine even 
when faced with lots of negative space. 

creating an otherworldly title screen
B Y  P E T E  C O L L I N S

Step One: You’ll want to use a thick font, preferably one that’s 

sans serif. The font used here is called Bebas and can be found 

for free at dafont.com. For this example, the document is 

7.5x7.5" at 150 ppi. Since it’s going to be a space theme, use 

white text on a black background. Press Command-I (PC: Ctrl-I) 

to invert your Background layer from white to black, and press 

D then X to set your Foreground color to white. Once you’ve set 

up your document, use the Type tool (T) to set some text in your 

document. Our beginning font size is 140 pt, and we selected 

the Center Text option in the Options Bar.

Step Two: Before we 

start resizing the text, 

let’s first adjust how 

the font looks. Make 

sure the Type tool is 

selected and the Char-

acter panel is open. To 

access the panel, go to 

Window>Character, 

or simply click on the 

panel icon just before 

the 3D icon in the 

Options Bar. Change 

the tracking settings to –75 to tighten the spacing between let-

ters. (Tracking is the third field on the right side of the panel.) 

That looks pretty good, but you can tweak the lower letters a 

touch more. With your Type tool, click between the W and the 

A, and press Option-Left Arrow (PC: Alt-Left Arrow) to tighten 

the space more. Do this between the A and R and the R and S, 

as well.

Step Three: We want 

the word WARS to 

be larger, so use the 

Type tool to select the 

bottom text, and in 

the Character panel, 

increase both the font 

size and the leading to 

210. (Leading is the 

space between lines 

of text.) Select both 

words and bold the 

letters to make them a 

bit chunkier by toggling on the Faux Bold option, which is the first 

letter T icon in the Character panel.

dafont.com
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Step Four: After you bolded the letters, you may have noticed 

that the crisp corners now have a slight bevel to them. Press 

Command-J (PC: Ctrl-J) to make a copy of the text layer so that 

you have a backup, and click the Eye icon next to the copied 

layer in the Layers panel to turn off its visibility. Right-click to the 

right of the original text layer’s thumbnail in the Layers panel 

and choose Rasterize Type from the menu that appears. Use the 

Rectangular Marquee tool (M) to select the top edge of one line 

of text. Press Delete (PC: Backspace) to trim off the top of the 

text to sharpen it. Repeat for the top and bottom of each line. 

This will clip a little of the rounded edges of the O and S, but 

that gives them character, which is always a bonus. You may 

also want to trim the ends of the S to make them parallel, as 

seen in this example.

Step Five: It’s time to add the hero or heroine. This technique 

works great with the letter A in our example, but you could try 

different letters according to the words and the shape of the 

hero that you’re using. With the Rectangular Marquee tool, 

select the black areas in the letter A, and press Option-Delete 

(PC: Alt-Backspace) to fill them with white to make it a solid tri-

angle. Using the Move tool, bring in your heroine image (we’ve 

already extracted her in the download files that are available for 

KelbyOne members). Press Command-T (PC: Ctrl-T) to bring up 

Free Transform, hold the Shift key, and drag a corner point to 

resize her to match the letter. Having a hero with a wider stance 

helps sell the idea of being part of the A. Drag her into position, 

and press Enter to commit the transformation.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/november-2014. 

All files are for personal use only.]

Step Six: Make a copy of the rasterized text layer by making it 

active in the Layers panel and pressing Command-J (PC: Ctrl-J). 

Turn off the visibility of the original rasterized text layer. Load the 

shape selection of your heroine by Command-clicking (PC: Ctrl-

clicking) on her thumbnail in the Layers panel. You should see 

the marching ants around the person. Click her Eye icon to hide 

her. With the copied rasterized text layer selected, press Delete 

(PC: Backspace) to cut out the person’s shape from the A. Press 

Command-D (PC: Ctrl-D) to deselect. That effect by itself looks 

pretty cool, but we’ll take it further.

Step Seven: Select the word OMNI with the Rectangular 

Marquee tool and press Delete (PC: Backspace) so that you 

just have the word WARS with the silhouette. We’ll use this 

to make the light shadow. Deselect. Turn back on the visibil-

ity of the original rasterized text layer and the heroine layer. 

Press Command-T (PC: Ctrl-T) to Free Transform the WARS 

layer, and pull the top-center transform handle down until 

the top of the hole in the letter R extends beyond the bottom 

of the page. While the handles are still showing, Right-click 

inside the box and choose Perspective. Now you can grab the 

bottom-right or -left handle and pull outward (you may need 

to drag out the corner of your document to see the handles). 

This will cause the text to spread out. Adjust until you like the 

look, and then press Enter.

Step Eight: We need to blur the light shadow. The easiest way 

to do this is to use Gaussian Blur, but the more effective way is 

to use the Tilt-Shift blur. Go to Filter>Blur Gallery>Tilt-Shift. Pull 

the top solid line off of the top of the page so there’s no blurring 

on the top portion of the image. Now drag the bottom solid line 

to just above the bottom edge of the word WARS and drag the 

dotted line just below it. This will keep the top edge of the light 

shadow more in focus and let the rest of the word be blurry. 

Crank up the Blur in the Blur Tools panel until it looks right to 

you and then press Enter.

Step Nine: Find a background image that will fit with the 

theme, drag it into the main document using the Move tool, 

and move it just above the original rasterized text layer in the 

Layers panel. You’ll want to clip this image inside the text layer, 

so place your cursor between to the two layers in the Layers 

panel, press-and-hold the Option (PC: Alt) key, and click. Now 

the image will only be seen through the lettering. The great 

thing about this technique is that you can Free Transform the 

background image to visually fit it. Check out the “Beginners’ 

Workshop” in this issue to learn more about clipping an image 

into text and other shapes.
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Step Ten: The image is coming along nicely, but you may want 

to drop the Opacity of the clipped background image in the Lay-

ers panel so it doesn’t look too busy and has a feeling of light-

ness. Now let’s give the background some stars by placing a star 

image as a layer just above the black Background layer. Use Free 

Transform to resize the star image to fill the document. Click on 

the Add Layer Mask icon (circle in a square) at the bottom of the 

Layers panel. Now select the Gradient tool (G), click on the gradi-

ent thumbnail in the Options Bar to open the Gradient Editor, 

select the Foreground to Transparent preset, and click OK. Select 

the Linear Gradient icon in the Options Bar, and press D then X to 

set your Foreground color to black. Start your gradient at a point 

just above the head of your hero and, while holding the Shift key 

to keep it straight, drag up to the middle of the word OMNI. This 

should give you a nice fade from black to the stars.

Step Eleven: To add to the lightness of the image, press X to 

change the Gradient tool to a white to transparent gradient, and 

select the Reflected Gradient icon (the fourth icon in the Options 

Bar). Create a new layer at the top of the layer stack. Start the 

gradient at the very bottom of the word WARS and, while holding 

Shift, drag down a very short distance to create a layer of light. 

Double-click the cloud brush that we included in the download 

files to load it into Photoshop. Set up the brush to have a light 

Opacity and Flow in the Options Bar, and on a new layer, use it to 

add some cloudy haze to the ground. You may need to use your 

Bracket keys to adjust the size of the brush to get the size clouds 

you want. Load Corey’s Flare Brush (also in the downloads), reset 

the Opacity and Flow to 100%, and create a new layer. Place the 

cursor over the outstretched hand of the heroine, use the Bracket 

keys to make the center of the brush a little larger than her hand, 

and click once to add a flare.

Step Twelve: Everything is looking really good, but there’s 

always going to be a little tweaking at the end. Our heroine 

needs to be a little cooler, so select her layer and then click on 

the Hue/Saturation icon in the Adjustments panel (first icon in the 

second row). To make sure that it only affects the layer immedi-

ately below, click on the first icon at the bottom of the Properties 

panel. Now check Colorize and move the Saturation, Hue, and 

Lightness sliders until you get the look you want. Once that is 

done, you may want to hold the Option (PC: Alt) key and drag-

and-drop a copy of that adjustment layer onto the text back-

ground image to match the coloring. Don’t forget to clip it so it 

only affects the text background image. Finally, make a copy of 

the flare layer, place it strategically on another part of the text, 

use Free Transform to resize and rotate it, and you’re done. 

The key points for this project are knowing how to tweak text, 

transform text with perspective, and clip images into text. They’re 

not very complex techniques, but once you understand how to 

work them, the sky’s the limit. ■ 
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Dance Out Diabetes is the brainstorm of Theresa Garnero, a regis-

tered nurse board certified in Advanced Diabetes Management. 

Dance Out Diabetes, which launched in 2010, holds monthly dance 

and exercise classes at which participants can get their blood glu-

cose levels, A1C (3-month glucose average), blood pressure, weight, 

and other metrics checked, plus pick up educational materials about 

living with diabetes. “There’s not much being done in the areas of 

diabetes prevention and management,” says Garnero. “We’re better 

with diagnosing and treating.” It’s an innovative concept that has 

attracted the interest of several national organizations. “People are 

imitating us left and right,” says Garnero. 

Garnero, who is a cartoonist and has won an international 

design contest herself, worked closely with a designer on the cur-

rent logo. The purple is part of a color palette used for their web-

site (www.danceoutdiabetes.org) and other materials. The “d,” 

taken from what Garnero calls a “friendly, funky font,” stands for 

diabetes and dance.

“We also wanted a person in there, so you can tell a person is at 

the center of all this,” she continues. The organization makes a point 

of being inclusive, so the dancing figure (drawn by Garnero) is neither 

race- nor gender-specific. 

Garnero likes the current logo’s colors and simplicity and its over-

all vibe. She’s not convinced the dancing figure works, “But how can 

you communicate that the person is dancing but isn’t another skinny 

white person?” she asks. (That’s mostly what you get when you type 

“dancer” into a stock photo search form.) Another concern is that 

the font for the spelled-out name gets hard to read at small sizes. 

In honor of Diabetes Month (November), we asked two designers 

to give Dance Out Diabetes a logo as energetic and innovative as the 

organization itself.

makeover submissions
WE’RE LOOKING FOR PRODUCT PACKAGING OR LABELS, PRINT ADVERTISEMENTS, WEBSITES, AND MAGAZINE COVERS THAT ARE CURRENTLY IN THE MAR-
KETPLACE FOR FUTURE “DESIGN MAKEOVERS.” SO IF YOU OR SOMEONE YOU KNOW HAS A DESIGN THAT YOU’D LIKE US TO CONSIDER MAKING OVER, OR 
IF YOU’RE A DESIGNER AND YOU’D LIKE TO BE CONSIDERED FOR A FUTURE “DESIGN MAKEOVER,” SEND US AN EMAIL AT LETTERS@PHOTOSHOPUSER.COM. 
(NOTE: THIS IS PURELY A DESIGN EXERCISE AND THE DESIGNERS DO NOT WORK DIRECTLY WITH THE CLIENT, CREATE FUNCTIONING WEBSITES, ETC.)

DesignMakeover
C O L U M N  ›  ›

JAKE WIDMAN

APPLICATION USED: Adobe Illustrator CS6

design dance
before

CLIENT
Dance Out Diabetes 
www.danceoutdiabetes.org

 ›  ›  D E S I G N  M A K E O V E R

I’m glad I had the chance to work on this project. I wanted to create 

a logo that’s fun and exciting and that shows the energy of dance.  

I used bright colors, curvy shapes, and unique letterforms to add a 

positive feel that reflects the attitude of the company and the people 

that work for it. The Dance Out Diabetes brand should be about hav-

ing fun and staying healthy, as well as staying in control of the disease.

The client likes the idea of including a dancer in the logo so long 

as it’s gender- and race-neutral. To accomplish that, I created a styl-

ized stick figure. Then I placed the figure on top of the letter “d” in 

a boisterous dance pose. The figure is meant to symbolize someone 

that’s healthy and in control of his or her body.

The letter “d” includes a flag at the top to make it look like a 

musical note, and all the letters in Dance were hand-drawn to look 

as if they’re dancing along with the figure. The combination of all 

these treatments brings a lot of fun to the logo, and that’s what 

I want people to think when they look at it: “This company looks 

like fun!”

On the bottom of the logo I added the rest of the company 

name, Out Diabetes, set in Monotype Corsiva, in a swooping flag 

that moves from left to right. Showing this movement symbolizes 

the idea that diabetes is being danced out of the equation.

The logo can be used in the full-color version or as plain white or 

plain black. In my opinion, the logo looks best in plain white on top 

of the company brand colors, as in the letterhead treatment. The 

figure and the letter “d” can also be used on their own as a smaller 

version of the logo, which would still read clearly at small sizes.

“The logo can be used in 
the full-color version or as 
plain white or plain black.”

“The organization makes a 
point of being inclusive, so 

the dancing figure is neither 
race- nor gender-specific.”

KEVIN ANDERTON
Kevin Anderton is a freelance designer living in the Kansas City area. He graduated from Virginia Commonwealth University in Richmond, 
Virginia, in 2003 with a bachelor of fine arts degree and has since been working in design. After getting his start in the Washington, D.C. 
area, he relocated to Kansas City in 2004 to be part of a growing arts community. “I have met some of the most amazing people out here,” 
he says. “I feel living in KC has taken my abilities to the next level.” 
	 After working for various companies and gaining nearly a decade of experience, he decided to start his own design business in August 
2013 (Kander10 Designs). “It’s been just over a year and I continue to break all of the goals that I have set for myself. I can’t wait to see what 
I can do in my second year.” 
	 His work ranges from designing magazines, catalogs, brochures, posters, T-shirts, and postcards to painting and drawing commissioned 
artwork. “It feels like I have worked on projects of all shapes and sizes,” he says.

DESIGNER
Kevin Anderton 
www.linkedin.com/profile/view?id=53611026

after

about the designer

www.danceoutdiabetes.org
mailto:LETTERS@PHOTOSHOPUSER.COM
www.danceoutdiabetes.org
www.linkedin.com/profile/view?id=53611026
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“…I wanted to create an 
expression of dancing through 
the letterface as a way to bring 

viewers into the experience 
without defining it for them.”

I wanted to make the Dance Out Diabetes logo something more 

streamlined and modern than what they currently have. I updated 

the logo in an effort to incorporate the idea of music and dancing 

together, while providing a more gender-neutral color scheme along 

with a font update. I wanted to create a logo that would pull in an 

audience from all ages, while still looking fun and inviting.

I took out the contour of the person because I didn’t want to 

define the image of the person dancing. Rather, I wanted to create 

an expression of dancing through the letterface as a way to bring 

viewers into the experience without defining it for them.

I used ITC Avant Garde Gothic as the copy text. I feel that it 

provides a nice, simple, round typeface that complements the sharp 

lines from the logo.

I created the logo in Adobe Illustrator, but only after reaching 

the final design through a process of ideation and mind mapping. 

Conceptual creation is the most important part of the design pro-

cess, and most of my time goes into the thought behind the design. 

I like to construct word clouds around important ideas in which  

I frame the concept of the design. After writing down any and every 

word that I can relate to the key idea, I start the iteration process. 

During this process, I designed 100 different ideas for the project in 

order to fully push the limits of the design. Exploring such a wide 

variety of conceptual ideas allows you to find the meaning in the 

small nuances that feed into the strength of the overall design. A 

good design isn’t the first idea thrown onto paper, but the one that 

has been given life through the creative process.

DANIEL ARPAIA
Daniel Arpaia is a 23-year-old designer in Austin, Texas. He received his bachelor of arts in graphic design from St. Edward’s University in Austin 
in 2013. From there, he moved on to an internship and eventually a production artist position at Austin’s Houndstooth Studio. Daniel’s disciplines 
and expertise range from computer-based programs to physical construction and sculpture to event production and experience.
	 Daniel has an appreciation for clean typefaces, while he tries to instill a sense of fun and abstract design, as well. He enjoys both interac-
tive and print work and is always looking to expand his fields of interest. “I am someone who loves to experience life in all its forms, and 
am always open to new experiences and whatever life brings my way,” he says. “I look forward to the journey, and can’t wait to see what 
opportunities will come.” ■ 

APPLICATION USED: Adobe Illustrator CC

DESIGNER
Daniel Arpaia 
http://darpaia.wordpress.com

after

about the designer

D E S I G N  M A K E O V E R  ›  ›

http://darpaia.wordpress.com
http://www.fjwestcott.com/light-modifiers/zeppelin/
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The Magic Hat Campaign: 
Event posters, T-shirts, and 
other items promoting a 
themed yearly nonprofit 
community festival

by
C O L U M N  › ›

CONFESSIONS OF A FORMER ZOMBIE

Paul Hebron

It all began with a grumble. I didn’t notice it at first, but looking back, I can see the warning signs as 

clear as day. I don’t know when exactly this zombie thing bit me, but the most important part is— 

I found a cure.

› › B Y  D E S I G N

and resignation. Sometimes, 

the grumble sessions made me 

bitter for days and eventually  

I started grumbling about my 

job outside of work.

It was during a self-reflec

tive drive to work that some-

thing clicked. I began to ask 

myself, “Why did I expect a company to manage my 

happiness and career expectations?” As I continued 

to reflect upon this question, I realized I was looking 

at my job as my career, thus seeking too much from  

my employer.

Let me explain how I see the difference between 

career and job by using the metaphor of a map and a 

vehicle. A career is your map and journey; a job is the 

vehicle that allows you to move along the map and 

have a journey. Like any journey, you might choose 

to sightsee along the way or even adjust your course 

or destination. When your job ceases to function as a 

vehicle and you’re only working for a paycheck, you 

might find yourself stuck and going nowhere in your 

career. It’s at that point a lot of people start looking 

for another job. I was happy with my career, but not 

happy with my job. I was stuck, not moving forward 

and no longer satisfied.

I loved the brand that I was in charge of, but after a 

few years, I realized I wasn’t moving forward. I wasn’t 

growing and gaining new experience. To complicate 

matters, some of my previous experience wasn’t being 

used in my current position. If I really wanted to move 

forward in my career, then I needed to freelance on the 

side, look for another job, or do both.

A NEW JOB ISN’T  
ALWAYS THE ANSWER
I began searching for another job. I wanted to work 

for a place that would make me feel excited about 

waking up in the mornings—an employer that would 

appreciate my contributions and allow me to do 

great work. It was during one of my interviews I be-

gan to notice a pattern. Every employer had its share 

of zombies. These were people with vacant eyes who 

passed me in the hallways as I was being lead to the 

interview room. They were drinking from giant jugs 

of coffee at 10 a.m. to help them function. These 

people, with resigned expressions, looked just like 

some of the ones I might be leaving at my current 

job. They looked just like me, another 9 to 5 zombie 

wanting to live again.

S everal years ago, my work life gradually began to 

decay. My job had lost the fun, the zing, and the chal-

lenge it had when I first started. I also noticed a similar 

change with my co-workers. I spent my lunch and break times 

listening to grumbles about what was wrong with management, 

the brands they worked on, and how unhappy they were. The 

more I listened, the more I found myself agreeing with some of 

their complaints.

Then one day, my nodding agreement turned into a growl-

ing rant about me going nowhere in my job no matter how 

hard I worked. I continued on about how unreasonable dead-

lines were and how tired I was of working weekends, taking 

work home at night and still not getting recognized for my 

extra efforts. All of this made me not want to go to work, but 

I came in anyway because I had deadlines. My co-workers 

moaned and groaned in agreement. It was done; I was now an 

official member of this zombie hoard.

You might be able relate to my situation. You’re sitting 

at your desk right now reading this article and realizing that 

you’re a zombie, too. Well, dear reader, let me share my story. 

Maybe you can walk away from this article with something of 

value, which could be your cure.

JOB VS. CAREER
I was the art director for an iconic brand. I worked long hours at my 

job, regularly going beyond expectations and creating really remark-

able work. Work that I’m still proud of to this day. Yet, anytime a pro-

motion was available, I was never in the running. After about six years, 

I began to feel overlooked and my desire to go to work had dimin-

ished. My emotions bounced around between frustration, anger, 

The Club House Logo: A nonprofit preschool

‘‘ ‘‘

I loved the brand  
that I was in  

charge of, but  
after a few years, 
I realized I wasn’t 
moving forward.
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I began to see that if I only switched jobs, I might become a 

repeat offender, going from one job to another thinking a new 

job would become the Holy Grail of eternal career happiness. 

That’s when I resolved to take some responsibility for my career 

and the happiness that came along with it. This led me down 

the path to giving away my time and talent. Why not? I had a 

full-time job with a decent salary that allowed me to pay the 

bills. I could at least spend a few hours a week working for free.

B Y  D E S I G N  › › › › B Y  D E S I G N

The first thing I did, as a way of breathing new life into my 

career, was to write a blog about some of my thoughts on 

creativity and design. I reached out on LinkedIn, connecting 

with other creatives to have conversations about design think-

ing, marketing, branding, and creativity. I also started seeking 

opportunities to work with nonprofits that might need creative 

help. I wanted to find an organization where I could practice 

design strategy and manage entire marketing campaigns.

VOLUNTEERING: A PRESCRIPTION  
FOR A ZOMBIE-FREE LIFE
Then, a funny thing happened; I wasn’t angry about my job any-

more. The more I connected outside of work, the happier I was at 

work. I was starting to grow my career and myself. It was a very 

liberating time. It was during this period that a couple of nonprofit 

organizations gave me the volunteer opportunities that I was seek-

ing. About a year after I started managing my own career, I was 

laid off. This was one of the most exciting transitions of my life.  

I was free to move on to the next destination on my career map.

Digital Media Design Club Logo and Event Posters: A student organization created to encourage interaction between industry professionals  
and students by regular speaker events, networking, and professional workshops on a college campus

Discover Wow Campaign: Utility bill inserts promoting a themed yearly nonprofit community festival 

‘‘ ‘‘It was during this period that a couple of  
nonprofit organizations gave me the volunteer 

opportunities that I was seeking.
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Six years later, I’m still volunteering, and now I have more 

than one vehicle to get me places. I’m excited about what each 

day might bring. I’m freelancing for a few awesome organiza-

tions and my volunteer projects keep me busy and satisfied. I’m 

on the board of two nonprofit groups and I also volunteer for 

the arts commission in my city. I’ve even managed to find time 

to take classes online and in the classroom.

Most of my volunteer responsibilities have little to do with 

creating graphics. Instead, I find myself working on outreach 

strategies to connect people in the community. I’ve been able 

to create social media and marketing campaigns from the 

ground up, reduce overhead, and increase revenue without 

decreasing service value.

By giving away my time and talent, I’ve gained more valu-

able career experience than I did when I was focused on what 

the job could do for my career. I’ve been able to cultivate and 

develop my leadership and management skills. I’ve learned 

to listen more and speak less, which has made me a better 

designer and creative manager.

I’ve worked with some awesome people, growing my per-

sonal connections and business network beyond what I could 

have imagined. In the process, I’ve discovered other skills that  

I really enjoy practicing. I’ve found new friends and mentors along 

the way and have been able to mentor others by sharing my 

experience. The exciting thing is I have nothing to grumble about.

FINAL DIAGNOSIS
My advice to zombies is this: enhance your career path by 

looking at volunteer opportunities in your community. Do 

something you can be passionate about outside of your job 

title and pick a cause to support. Use volunteering as a way 

to stretch your skills beyond what you’re doing at your cur-

rent job. I’ve discovered that volunteers are usually passionate 

people and are great to connect with toward building your 

network. Most nonprofits appreciate volunteers so much that 

they will let you know how much they value your time, expe-

rience, and contributions.

Finally, I’m not advocating you leave a full-time job to vol-

unteer. Even a bad job brings a regular paycheck. What I am 

saying is if you’ve become a zombie at work and feel stuck in 

your career, look at other vehicles to help get you where you 

desire to go. Design your career path to include opportunities 

to grow outside of a job. By doing this, you just might find the 

cure you’ve been seeking. ■

B Y  D E S I G N  › › 

ALL DESIGNS BY PAUL HEBRON

The Way Logo: A faith-based youth organization created to awaken and facilitate artistic talents in youth via classes and events

http://www.precision-camera.com
http://www.bhphotovideo.com
http://www.arlingtoncamera.com/shop/


http://www.epson.com/cgi-bin/Store/jsp/Landing/finish-strong_ad.do?ref=van_ad_fsmain
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THE HAND-TINTED  
BLACK-AND-WHITE LOOK
THERE AREN’T MANY POSTPROCESSING TECHNIQUES THAT CAN 

EVOKE A SENSE OF TIMELESSNESS OR NOSTALGIA QUITE LIKE A 

BLACK-AND-WHITE (B&W) PHOTO. BY RELYING ON TONALITY AS 

A PRIMARY VEHICLE TO CONVEY THE MOOD AND STORY OF A 

B&W PHOTO, YOU CAN ACHIEVE ALL SORTS OF CREATIVE RESULTS. 

HOWEVER, THERE IS A TECHNIQUE THAT I ENJOY EXPERIMENTING 

WITH THAT I REFER TO AS “HAND-TINTED B&W,” WHICH ALLOWS 

Browse through any of the popular photo websites or social media networks and you’ll see something evident: photog-

raphers love stylizing their photos. And why shouldn’t they? The software that we have at our disposal lets us do such 

wonderful and amazing things as we try to infuse our own individual sense of creativity into our images. In this feature, the 

immensely talented photographer and author (and my wife!), Nicole S. Young, and I will take a look at four of the most 

popular and trending postprocessing techniques and walk you through how to apply them to your own photos. Give each of 

them a try and, as with any delicious culinary dish, keep experimenting and adjusting to taste.

WAYS TO STYLIZE YOUR PHOTOGRAPHS
Quick Easy

: To illustrate this technique, I’m using a photo 

I took of my nephew, Hunter, during a 4th of July celebra-

tion. For reference, I’m using Adobe Photoshop CC 2014 

but this should also be applicable to all Photoshop CC users. 

Open one of your own images to follow along. 

: The first thing you’ll want to do is duplicate 

your Background layer by pressing Command-J (PC: Ctrl-J). 

Now that we have our duplicate layer, it’s time to start 

the B&W conversion process. My favorite way to do this 

in Photoshop is to use the powerful adjustment layers. At 

the bottom of the Layers panel, click on the Create New 

Adjustment Layer icon (it looks sort of like the contrast 

symbol) and select Black & White from the pop-up menu. 

You’ll have a basic B&W treatment applied to your image 

that’s relatively flat and that’s OK. 

: The next step is to adjust the tone of the 

different colors that are in your image. It may sound 

odd to talk about adjusting colors like reds and greens 

on your B&W image, but it will make much more sense 

once you start experimenting. When you select the newly 

created B&W adjustment layer, you’ll see six color sliders 

in the Properties panel. Dragging a slider to the left or 

right will affect the base colors in your image; however, 

I prefer using the Targeted Adjustment tool (hand with 

two arrows). With the Targeted Adjustment tool active, 

all you have to do is hover over your image, click-and-

hold the dropper on a region that you want to adjust, 

and drag left or right. Dragging left will decrease—or 

darken—that color, and dragging right will increase—

or brighten—that color. For the purpose of this photo, 

I want Hunter to really pop and stand apart from the 

grass. To start, I position the dropper on the grass and 

drag to the left, which darkens it quite nicely. Addition-

ally, I’m going to click the dropper on Hunter’s face and 

drag to the right a bit, which will bring out the reds and 

yellows of his skin, as well as his shirt.

: While we’re making good progress with the 

photo, it looks like it needs a bit of a Levels adjustment. 

Click on the Create New Adjustment Layer icon in the Layers 

panel again and select Levels. From here, you can adjust the 

white and black points of the image to make it pop. 

YOU TO RESTORE VERY SUBTLE AMOUNTS OF COLOR BACK INTO 

THE IMAGE.

THIS ISN’T QUITE LIKE SELECTIVE COLORIZATION OF A B&W 

PHOTO, WHERE YOU CONVERT YOUR IMAGE TO PURE B&W 

AND MASK BACK IN THE ORIGINAL COLOR OF A SPECIFIC AREA 

OF THE FRAME. SOME COMMON EXAMPLES OF SELECTIVE 

COLORIZATION WOULD BE PAINTING BACK THE COLORS OF A 

BOUQUET OF FLOWERS IN A WEDDING PHOTO, OR RESTORING 

THE COLOR OF THE EYES IN A PORTRAIT PHOTO. THIS TECH-

NIQUE COULD BE CLASSIFIED IN THE SAME FAMILY, BUT AS A 

MUCH MORE DISTANT COUSIN AS THE RESULTS ARE INTENDED 

TO BE WAY MORE SUBTLE AND APPLIED GLOBALLY.

Brian Matiash
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: This step is optional depending on whether you 

want to apply a global tint to your photo. This is useful if you 

want to replicate a sepia or cyanotype look. In this case, let’s 

add a slightly burnt-orange tint to give it that vintage feel. To 

start, select the Black & White adjustment layer in the Layers 

panel and duplicate it by pressing Command-J (PC: Ctrl-J). 

Double-click the layer’s name and rename it with something 

identifiable like “Tint” to make it easier to find in the future.

: Click the Tint checkbox in the Properties panel to 

apply a tinted color overlay on top of your image. To get that 

aged, vintage look, click on the color swatch next to Tint to 

open the Color Picker and select a color in the darker orange 

region. To make it easier to see the color, select a darker ver-

sion of the color in the Color Picker and then decrease the Tint 

layer Opacity in the Layers panel until you reach the desired 

subtle result. 

: Now you’re ready to begin hand-tinting the  

image. For this photo, there are five primary areas that we can 

hand-tint: the hair, skin, clothing, sneakers, and grass. We’ll start 

with the largest area, which is the grass. Create a new layer by 

pressing Shift-Command-N (PC: 

Shift-Ctrl-N), name the new 

layer something identifiable like 

“Grass,” and click OK. With the 

new Grass layer selected, choose 

the Brush tool by pressing B and 

select your Foreground color. In 

this case, we wanted to go with 

a normal-to-dark green.

: Begin painting the color on the appropriate area 

of your image. In its current state, you may be alarmed because 

you’re essentially just spilling color onto your image but it will 

make sense in a minute. If you accidentally spill color onto part of 

your image that you didn’t intend to, just select that color layer in 

the Layers panel, click the Add Layer Mask icon (circle in a square) 

at the bottom of the panel, and paint on the mask with black as 

your Foreground color. 

: Now it’s time to properly blend the painted color. 

Select the color layer and change the blend mode to Multiply in 

the Layers panel. Decrease the Opacity so that only a tiny bit of 

color is visible. In most cases, I find great results happen between 

5–15% Opacity. To continue, simply repeat this process on each 

part of the image. You’ll want to use a separate layer for each 

color that you hand-tint, allowing you to go back and modify as 

you see fit.

THE Split-Toned  
RETRO LOOK
ONE OF THE MOST POPULAR LOOKS BEING APPLIED TO  

IMAGES LATELY IS THE SPLIT-TONED RETRO LOOK, AND 

IT’S NOT HARD TO UNDERSTAND WHY. SPLIT TONING  

ALLOWS YOU TO TINT THE BRIGHT (HIGHLIGHTS) AND 

DARK (SHADOWS) AREAS OF YOUR IMAGE BY SELECTING 

THEIR RESPECTIVE COLORS. EXPERIMENTATION IS KEY, 

AND AS YOU BECOME MORE COMFORTABLE WITH HOW 

SPLIT TONING AFFECTS THE LOOK OF YOUR IMAGES, THE 

FASTER YOU’LL DEVELOP YOUR OWN SIGNATURE LOOK. 

IN THIS EXAMPLE, WE’RE GOING TO USE A PHOTO I TOOK 

OF MY ADORABLE NIECE, ASHLYN.  

Brian Matiash

: Start by opening a photo in Photoshop. Dupli-

cate the Background layer by pressing Command-J (PC: 

Ctrl-J). Convert the duplicate layer into a smart object by go-

ing to Layer>Smart Objects>Convert to Smart Object. Doing 

this will allow you to always go back and change the split-

tone effect with ease. 

: Split toning is easy in Photoshop CC. Go to 

Filter>Camera Raw Filter. This will bring up Camera Raw, 

which contains a ton of really 

cool tools and utilities to edit 

your images. If you’re familiar 

with Adobe Lightroom, then 

you should find yourself very 

comfortable with Camera Raw. 

To start, click on the Split Ton-

ing tab below the histogram, 

which will bring up the Split 

Toning panel.

: The Split Toning panel is straightforward once 

you get used to it. Think of it as two identical tinting tools: one 

for the Highlights and one for the Shadows. With the Camera 

Raw implementation of Split Toning, there are two ways for 

you to choose the hues for your tints. The first way is sort of 

like guessing by dragging on the Hue and Saturation sliders. 

The Hue slider is used to choose a particular hue in either the 

highlights or the shadows, depending on which section you’re 

working on. Don’t worry if you start dragging the Hue slider 

up and down without seeing any changes to your image. This 

has to do with the default state of the Saturation slider, which 

is 0 (zero), whereby no color will be shown. HOWEVER, AS 

YOU BRING THE SATURATION SLIDER TO ITS MAXIMUM 

STATE OF 100, YOU’LL QUICKLY SEE THE HUE COLOR 

YOU’VE SELECTED COME THROUGH.

The other way to choose the hue is to hold down the 

Option (PC: Alt) key while dragging on the Hue sliders. This 

will display the hue at 100% saturation, even if you have a 

lower Saturation level selected. This makes it easy to know 

exactly which hue you’re selecting. Once you have your high-

light and shadow hue and saturation selected, you can bias it 

toward one or the other using the Balance slider. Dragging to 

the left biases toward the Shadows color and dragging to the 

right biases toward the Highlights color.

THE HAND-TINTED 
BLACK-AND-WHITE LOOK CONTINUED
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: A popular highlight and shadow hue 

combination is orange and blue, respectively. Use 

both sets of Hue and Saturation to dial those in and 

bias toward the Highlights using the Balance slider. 

You can immediately see the results on the image.
 

 

: An optional step to take things further 

is to play with blend modes to accentuate the split-

toned look. Start by duplicating the split-toned layer 

you just created. Because that first split-toned layer 

was converted to a smart object, you can easily ac-

cess those settings on the duplicate layer by double-

clicking on the Camera Raw Filter adjustment. Now 

that you’re back in Camera Raw, navigate to the Split 

Toning panel and invert the Hue values of the High-

lights and Shadows. In this case, I opted to go more  

extreme with the blues of the highlights. Clicking 

OK will return you back to Photoshop.

:  Now it’s time to blend the two split-

toned layers together. With the top layer selected, 

choose Color Burn from the blend mode drop-down 

menu. This will result in a harsh-looking image but 

the key is to adjust the layer Opacity to taste. Drop 

the layer Opacity until you start to see some color 

and detail appear in the darker shadow areas of the 

image. Additionally, you can add a layer mask to the 

top split-toned layer and use the Brush tool at a low 

Opacity in the Options Bar to tone down some of 

that blending effect. 

TEXTURE CAN ADD MYSTERY, DEPTH, REFINEMENT, AND IN-

TRIGUE TO ANY PHOTOGRAPH. THERE ARE MANY DIFFERENT 

WAYS TO ADD AND BLEND TEXTURE, AND FOR THIS EXAM-

PLE, I’LL SHOW YOU HOW TO GO A LITTLE MORE ADVANCED 

USING THE LAYER STYLE DIALOG.

: Start out with two photos opened in Photoshop 

CC: The main image (a photo of my niece in this example), as 

well as the texture that you want to apply to it.

Nicole S Young: First, we need to get the texture image over 

to the main photo. Make sure that the texture image  

is active, and go to Select>All in the menu. You’ll see  

the marching ants around the edges of the window.  

Then, go to Edit>Copy to 

copy the contents of the 

document. Now, activate 

the other image, and go 

to Edit>Paste. The texture 

will appear over top of 

the main image and on 

its own layer.

: The texture image is a little too small, so 

it will need to be resized. With the texture layer still ac-

tive, press Command-T (PC: Ctrl-T) for Free Transform, and 

resize the texture so that it covers the entire layer. When 

you’re finished, press Enter to commit the transformation.

: Next, we need to access the Blending Op-

tions in the Layer Style dialog for the texture layer, so go 

to Layer>Layer Style>Blending Options, and the Layer Style 

dialog will pop up. NOW COMES THE FUN PART. In the 

Blending Options section, move your attention down to 

the Blend If section. Then, in the This Layer section, press-

and-hold the Option (PC: Alt) key and click the right slider 

to split it. Drag the left half of the right slider to the left 

until you start to see the original image below reveal itself.

THE Split-Toned  
RETRO LOOK CONTINUED

ADDING Texture
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: Now turn your attention to the Under-

lying Layer section. Press-and-hold the Option (PC: 

Alt) key again, and drag the right half of the left 

slider toward the right to reveal some of the darker 

sections of the original image. 

: Because the texture image had some 

color in it, I’m going to desaturate it using the Lay-

er Style dialog. Click on the Color Overlay section 

to bring up the options for this section. (TIP: BE 

SURE TO CLICK ON THE ACTUAL TEXT OF THE 

SECTION TO BRING UP THE OPTIONS; IF YOU 

JUST CHECK THE BOX THEN YOU WON’T BE 

ABLE TO MAKE ANY CHANGES.) Click on the 

color swatch, change the color to black, and click 

OK. Set the Blend Mode to Color, and reduce the 

Opacity (I set mine to 33%). When you’re finished, 

click OK.

: Some of the texture is showing up on 

her face and skin, so let’s use some basic masking 

to remove it. Add a new layer mask (Layer>Layer 

Mask>Reveal All), select the Brush tool (B) with a 

soft-edged brush, and press D then X to set the brush 

color to black. Then, in the Options Bar at the top, set 

the Brush Opacity to 30% and start painting over the 

face and skin (or whichever area in your image you 

would like to reveal). Let’s soften the overall texture 

in the image. Go to the Layers panel and reduce the 

Opacity of the texture layer. For this image, I set it 

to 70%.

LENS Flare
MOST OF THE TIME, PHOTOGRAPHERS WANT 

TO PREVENT LENS FLARE. IT CAN OFTEN ADD AN 

UNWANTED ARTIFACT TO AN OTHERWISE GOR-

GEOUS PHOTOGRAPH. WHEN USED PROPERLY, 

HOWEVER, IT CAN ADD STYLE AND DRAMA TO 

AN IMAGE, TOO. FOR THIS SECTION, I’M GOING 

TO SHOW YOU HOW TO ADD A BEAUTIFUL 

AND STRIKING LENS FLARE IN PHOTOSHOP CC.

: I’ll begin with a photo of Ashlyn, my 

youngest niece. This photo was shot with the sun-

light coming from behind, adding a nice, bright 

glow around her hair; however, I would like to add 

a bit hazier sun-flare effect to it.

: To add the flare effect, 

start by adding a new blank layer to 

your image. To do this, click on the 

Create a New Layer icon at the bot-

tom of the Layers panel. Next, press D 

to set the Foreground color to black, 

then press Option-Delete (PC: Alt-

Backspace) to fill the layer with black.

: Go to Filter>Render> 

Lens Flare to bring up the Lens Flare 

dialog. THIS IS WHERE YOU GET 

TO START HAVING SOME FUN 

WITH FLARE! For the first flare, 

I located it toward the left side of 

the frame (click-and-drag inside the 

preview to move the flare), set the 

Brightness to 163%, and selected 

the 35mm Prime Lens Type option. 

Click OK.

: The top layer is still 

fully covering the main photo, so to 

reveal the layer below, change the 

blend mode of the lens flare layer 

to Screen in the Layers panel. This 

will hide the black in the layer and 

only reveal the bright parts (in other 

words, it will hide everything but the 

lens flare).

ADDING TEXTURE CONTINUED

Nicole S. Young
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: Now add another lens flare to the image 

by again going to Filter>Render>Lens Flare. This time, 

place the flare in the top-left corner, select the 105mm 

Prime in the Lens Type, and set the Brightness to 210%. 

Click OK. The flare effect is too powerful and needs to 

be reduced. To do this, go to Edit>Fade Lens Flare and 

set the Opacity to 50%.

: Now let’s add one last lens flare to this 

image to soften and brighten the lower-right por-

tion of the photo. With the top layer still active, go to 

Filter>Render>Lens Flare to bring the Lens Flare options 

up once again. This time, position the lens flare in the 

lower-right portion of the frame, set the Brightness to 

147%, and select 105mm Prime for the Lens Type. 

Click OK. Then, reduce the Opacity of the lens flare 

layer to 80% to soften the overall effect.

: For the last step, let’s add some basic 

processing to this photo to finish it and bring back 

a little bit of contrast. Add a Levels adjustment layer 

(Layer>New Adjustment Layer>Levels) and set the left 

slider to the right to darken the photo. Add a default 

Black & White adjustment layer, and then change this 

layer’s blend mode to Soft Light. Reduce the Opacity of 

the layer to 60% to complete the effect. ■

LENS FLARE CONTINUED

http://www.portraitprofessional.com
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Photo Through Text
Step One: Choose File>New to create a new document (say, 

1600x1200 pixels at 72 ppi for Web or 300 ppi for print). Press T  

to grab the Type tool. To mask an image with a word, click in 

the document and enter the word (6 letters or less is best) using 

a thick font (e.g., Impact or Arial Bold). For this part of the tuto-

rial, we’re masking a different image with each individual letter. 

To mask a different image with each letter, enter one letter and 

then Shift-click in the document to force Photoshop to create 

another type layer, enter the next letter, and repeat. Text color 

doesn’t matter.

Step Two: With the final type layer active, Shift-click the first 

type layer to select all the type layers (if you entered each let-

ter on its own layer). Press V to grab the Move tool and, in the 

Options Bar, click the Align Bottom Edges icon. To create equal 

spacing between letters, activate each type layer individually and, 

with the Move tool active, tap the Left or Right Arrow keys. To 

reposition the whole word, select all type layers and, with the 

Move tool selected, click-and-drag to reposition. 

Step Three: Activate the first type layer and choose File>Place 

Embedded. In the resulting dialog, find a photo and click Place. 

Photoshop adds the image as a smart object above the active 

layer and puts it in a bounding box. Resize as needed and press 

Enter to commit the transformation. (Note: You can resize smart 

object content multiple times without quality loss.) With your 

image in place, choose Layer>Create Clipping Mask. Tip: Alter-

natively, press-and-hold Option (PC: Alt) while pointing your cur-

sor at the dividing line between the layers, and click when your 

cursor turns into a square with a down-pointing arrow. 

Step Four: With the smart object layer selected, use the Move 

tool to reposition the image inside the letter. To resize the 

image, press Command-T (PC: Ctrl-T) to bring up the Free Trans-

form bounding box, and Shift-drag any corner handle inward 

to shrink or outward to enlarge, as shown here. Press Enter to 

accept the transformation. 

Text: Step Two

Text: Step One

Text: Step Three

Text: Step Four

Text: Step Five

Text: Step Six

Text: Step Nine

LESA SNIDER

Clipping masks are like the Photoshop version of stencils; they let you take one layer’s content and push it through 
the solid area of the layer beneath it. In this column, you’ll learn how to mask imagery using type and shape  
layers, as well as brushstrokes drawn on an empty image layer.

Beginners' Workshop
 conquering clipping masks

Step Five: Activate the second type layer and repeat Steps Three 

and Four until you’ve clipped a different image to each type layer. 

Step Six: Activate the first type layer and click the Add a Layer 

Style icon (ƒx) at the bottom of the Layers panel. Choose Stroke 

and, in the resulting dialog, enter 5 px for Size, Inside for Position 

(for straight corners), and click the Color swatch. In the resulting 

Color Picker, mouse over to the document and click to snatch 

a color from one of the images; keep clicking until you find a 

stroke color you like. Click OK to close the Color Picker, but don’t 

close the Layer Style dialog. 

Step Seven: In the Layer Style dialog, click Drop Shadow under 

the Styles list on the left. Set Size to 13 px and reposition the 

shadow by clicking-and-dragging atop your document. Click OK. 

Step Eight: Choose Layer>Layer Style> 

Copy Layer Style. Command-click (PC: 

Ctrl-click) to activate the other type lay-

ers and choose Layer>Layer Style>Paste 

Layer Style. Tip: You can also Right-click 

on a layer name to access the Copy/

Paste Layer Style commands. 

Step Nine: Choose File>Save As and 

choose Photoshop from the Format 

menu. Here’s the finished product after 

adding promotional copy.
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Photo Through Shape or Illustration
Masking with a shape layer, or a vector illustration that you’ve 
placed as a smart object, works the same way. They key is to 
position the shape layer or smart object below the layer you’re 
clipping it to. 

Step One: Open a photo by choosing File>Open As Smart 

Object. Activate the Custom Shape tool (nested under the Rect-

angle tool [U]). In the Options Bar, make sure the drop-down 

menu on the left is set to Shape, click the Fill menu and pick 

any color, and set the Stroke menu to No Color. Click the Shape 

drop-down menu, click the gear icon in the resulting menu, and 

choose All. In the resulting dialog, click Append. 

Step Two: Click to activate a shape, then mouse over to your 

document and Shift-click-and-drag to draw it. (Tip: Press the 

Spacebar to reposition as you draw.) To rotate it, press Com-

mand-T (PC: Ctrl-T), move your cursor outside of the bounding 

box until you see a curved double arrow, then click-and-drag to 

rotate. Reposition the shape by dragging inside the bounding 

box. Press Enter to accept. 

Step Three: In the Layers panel, drag the shape layer beneath 

the smart object. Activate the smart object layer and choose 

Layer>Create Clipping Mask. To reposition the photo and shape, 

activate both layers and use the Move tool. Here’s the final result, 

after placing another image for texture at the bottom of the layer 

stack, and adding a drop shadow to the shape layer. 

Photo Through Brushstroke
Step One: Open an image as a smart object and then add a new 

layer below the currently active one by Command-clicking (PC: Ctrl-

clicking) the Create a New Layer icon at the bottom of the Layers 

panel. Activate the smart object and choose Layer>Create Clipping 

Mask. Your document turns transparent, but you’ll fix that next. 

Step Two: Press B to grab the Brush tool. In the Options Bar, 

click the Brush Preset Picker and, in the resulting menu, click the 

gear icon. Choose Faux Finish Brushes and click Append in the 

resulting dialog. Scroll until you find the Stencil Sponge – Twirl 

brush and click it. 

Step Three: Activate the empty layer and make the brush big 

by tapping the Right Bracket key (]). Click or click-and-drag to 

add paint to the layer, which the photo shows through. Here’s 

the final result after adding a solid white fill layer. To add a new 

fill layer, choose Layer>New Fill Layer>Solid Color, and click OK. 

In the Color Picker, set the color to white (R:255, G:255, B:255), 

click OK, and drag the fill layer to the bottom of the Layers panel. 

Until next time, may the creative force be with you all. ■

Shape: Step One

Shape: Step Two

Shape: Step Three

Brushstroke: Step Two

Brushstroke: Step Three

Brushstroke: Step One
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When I first decided to write about adopting a medium- 
format system into my workflow, I chose the title on 
the previous page. It sounded dramatic and definitive! 
The more I thought about it, however, the more  
I realized it wasn’t entirely accurate. Here’s why: as with 
all the classic and polarizing photography arguments, 
such as JPEG vs. RAW, Nikon vs. Canon, small flashes 
vs. studio strobes, medium format vs. DSLR, etc., the 
important thing to remember is that each of these do 
what they do extremely well in the right circumstances. 
People seem to get so attached to one camp or 
another that they lose sight of the fact that none of 
these technologies are mutually exclusive. They’re all 
different tools meant for different purposes and they 
can all peacefully coexist in one big happy photography 
universe. I promise it’s true. It would be more accurate 
to say that I added medium-format digital to my bag of 
tricks. Did I kick my DSLR to the curb? Of course not.  
I just use it less and for tasks medium format isn’t well 
suited for, and vice versa. In fact, every photographer  
I know who’s made the switch still uses both DSLR and 
medium format because of their very different and 
distinct feature sets and capabilities.
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that vast, that the 14-bit files and 14 stops of dynamic range 
don’t make a difference, that a sensor almost twice the size of the 
one in my full-frame DSLR doesn’t matter, that all the claims were 
wrong. No such luck. 

Everyone raved about the quality, the unparalleled detail, and the 
amazing tonal range. They advised that I needed to test drive the 
systems being considered, and that once I did I’d see for myself why 
they were such ardent supporters of medium format. I knew this was 
the only way to separate the wheat from the chaff, but I was hesitant 
to take the step. Once I had a medium-format system in my hands,  
I was sure I was going to be a goner. It would be a tall order to get 
it away from me. 

The more I weighed the options and capabilities of Phase One’s 
60-megapixel IQ260 compared to the 50-megapixel IQ250, the 
more obvious it became that for my shooting style the IQ250 was 
a better fit. As someone migrating from DSLR, I appreciated the 
flexibility of the IQ250’s 100–6400 ISO range, something unavail-
able with the CCD-based IQ260. The IQ250 was definitely the 
stronger contender based on the type of work I do: fashion, por-
trait, editorial, and weddings where ISO flexibility is essential. The 
one mental hurdle I had to overcome was that due to current size 
limitations in the CMOS production process, the IQ250 is based 
on a 1.3x crop sensor. It took some time to get over that but in the 
end ISO flexibility was the deciding factor and 50 megapixels was 
more than enough for my purposes. For architectural, interior, or 
landscape shooters requiring the widest possible 
field of view, the full-frame, CCD-based IQ260 
is probably a better fit.

Basically, the IQ250 and other CMOS-based, 
medium-format systems are now freed from 
their traditional studio and strobe-reliant con-
straints. Until CMOS entered the picture, nat-
ural and low-light shooting weren’t practical 
with medium format. Even in situations where 
a mixture of ambient and artificial light is being 
used, the flexibility to capture clean files at ISO 
settings above 400 is a big plus. This is made 
possible by the IQ250’s Sony-manufactured 
33x44mm CMOS sensor, technology I was 
already comfortable with, only now in a larger 
format and with a whopping 50 megapixels. 
It’s important to remember that it’s not all 
about bit depth and pixels. Many DSLRs are 14 

Considering a new camera system of any kind is 
a weighty affair that involves investing not only in 
a new body, but new lenses, batteries, chargers, 
accessories, and more. For me, it was important 
to look past all the hype and play a hard game 
of devil’s advocate as I pondered stepping into 
medium format. It’s so easy to get caught up in 
all the drool-worthy, must-have technology that 
marketing executives are so good at making us 
desire. But at the end of the day you’re better 
off taking a hard, sober look at what the realities 
are. I asked myself and anyone who’d listen a 
series of important questions, such as what is 
the return on investment; will this tool make me 
better at what I do; will it increase my bottom 
line; do clients know the difference; do they ask 
for it; will it permit me to accept work I currently 
can’t; are the differences in quality extreme 
enough to justify the expense; will it work with 
my current computer and software; is it suited 
to my style of shooting; and how much does 
the luxury brand/cool kid, I-wanna-be-a-badass 
factor play into it?

I reached out to as many people as  
I could, those with real-world medium- 
format experience, from manufacturers to 
photographers, some with years of medium- 
format digital under their belts and  
others who recently made the transition.  
I targeted my outreach to those experienced 
and knowledgeable about the systems I was 
considering. At the time, it was a toss-up 
between two Phase One digital backs: the 
IQ260, which uses the venerable CCD, and 
their new CMOS-based IQ250. Both attach 
to medium-format bodies, in this case a 
Phase One 645DF+. After more conversa-
tions than I can count, it became clear that 
what I was looking for was someone, any-
one, to tell me that medium format really 
wasn’t everything it’s cracked up to be.  
I was hoping someone would tell me the 
investment wasn’t worth it, that the quality 
gap between medium format and DSLR isn’t 
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All Images by Michael Corsentino Except Where Noted

bit, with some reaching into the 30-megapixel range. 

Apart from the staggering level of detail, there’s something about 
the files from a medium-format digital camera that has to be seen to 
be believed. You’ll often hear it referred to as “the medium-format 
look,” best described as a painterly rendering of tones made possible 
by 14 stops of dynamic range and other factors, such as sensor size 
and best-in-class lens optics. I’m here to tell you it’s not a bunch of 
hype. Furthermore, the proprietary software each manufacturer uses 
to interact with the sensor and process RAW conversions later in post 
also plays a key role in details, color gradation, and edge definition. 
This is why digital backs with exactly the same Sony CMOS medium-
format sensor have different capabilities and produce files with 
different looks and qualities. 

I scheduled several test shoots where I could put a loaner 
IQ250, 645DF+ body, and a Schneider Kreuznach 80mm f/2.8 
leaf shutter lens through their paces in a low-stress, no-pressure 
environment. As I feared, and much to my chagrin, once I made 
my first exposure I was instantly hooked by the quality, micro 
detail, skin tones, ease and speed of shooting tethered, beautiful 
LCD previews, the digital back’s touch-screen interface, wireless 
iPad proofing with synced star ratings, and the 1/1600 leaf shut-
ter flash sync speed—all ridiculously cool. 

There simply was no comparison to my DSLR; it left those 
files in the dust. The quality I was getting made me look at my 
once-fancy DSLR like it was a lonely stepchild and left me wishing  
I could go back and reshoot my favorite images with medium 
format. Seriously, game over! Then it became a question of what 
was the best way to make owning a system a reality. With the 
attractive financing available, qualified borrowers are looking at 
somewhere around $500 a month to own a system like the Phase 
One IQ250, which seems like a reasonable business expense. 

There are 
p r eowned 
options start-
ing well under 
$5,000. The 
other piece of good news is that when it comes to lifespan and 
holding value, digital backs far outpace DSLRs, which need to be 
replaced every few years and typically have little or no value left.  
I know people producing beautiful images with 15-year-old digi-
tal backs. When they’re ready, they can trade them in and put the 
thousands of dollars in remaining value into a new digital back. 
Try that with a DSLR. 

I’m not going to lie and say that medium format’s curb appeal isn’t 
a plus; of course it is. Perception is reality and there’s definitely juice 
to be had from showing up in a Ferrari; however, when it’s all said 
and done the deciding factor for me was quality. Like you, I take my 
business and art seriously. The ability to consistently deliver the best 
images possible created with the best tools available is what medium 
format is all about. By its very nature, the slower, more deliberate 
pace of medium format helps me be more thoughtful, and produce 
better images requiring less work in post. The medium itself inspires 
me to live up to its possibilities and continuously push myself to 
create new and exciting work and be the best I can be. When it 
comes to medium format, I’m sold! ■
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http://www.topazlabs.com/mktg/psuser-lake.html


› 
› 

k
e

l
b

y
o

n
e

.c
o

m

085

A great photograph is built on a great exposure. Ansel 

Adams knew this. The great landscape photographer 

and master of the negative and print said, “The neg-

ative is comparable to the composer’s score and the print to its 

performance. Each performance differs in subtle ways.”

A photographic RAW file is the undeveloped negative. The 

interpretation of that digital negative in Camera Raw is the per-

formance Adams cites. The proper exposure of his film negatives 

formed the foundation for his amazing prints. Today, shooting 

onto digital sensors, that proper exposure is just as critical for a 

RAW or JPEG capture even though it seems that mistakes can 

be corrected in postproduction. Proper exposure provides the 

headroom for creative expression in post. 

WHAT IS EXPOSURE?
Exposure is the amount of light that reveals the true tone of the 

subject in a photograph. The amount of light making up an expo-

sure is controlled by a combination of ISO, aperture, and shutter 

speed: ISO is the sensitivity of the sensor, aperture is the amount of 

light passing through the lens, and shutter speed is the length of 

time the light strikes the sensor. 

These are the camera controls that set the exposure. When 

camera automation is involved, the exposure compensation 

settings allow the auto setting to be refined. Additionally, a 

proper exposure wants to have reproducible detail in both the 

highlights and the shadow. Achieving that exposure requires an 

understanding of how light is measured. There are two kinds of 

light meters—reflected and incident. 

MEASURING LIGHT
I’ll say it right here. Exposure can be really confusing, particularly 

with modern digital cameras. Why? First, there’s that screen on the 

› › L I G H T  I T

THE STRATEGY, THE GOAL THAT EVERY 

PHOTOGRAPHER HAS IS TO CREATE 

A COMPELLING, MEMORABLE IMAGE. THE TACTICS  

FOR MAKING THIS STRATEGY A REALITY INCLUDE  

CONCEPT, COMPOSITION, AND EXPOSURE—THE LAT-

TER ARGUABLY THE MOST IMPORTANT FOUNDATION 

OF ANY PHOTOGRAPH. 

By Kevin 
Ames

 >>LIGHT IT

TACTICS
EXPOSURE

back of the camera that seduces us into believing we nailed it. 

Second is the type of light meters built into the cameras.

REFLECTED METERING
Those in-camera meters are reflected meters. They measure the 

amount of light bouncing off of a subject. A reflected meter’s 

exposure makes whatever amount of light bouncing off a subject 

12.5% gray. Always.

Here’s an easy experiment that shows what a reflected 

meter does. Take a white card and a black card outside on 

a sunny day. Put your camera on P (for Professional—er, no, 

that’s actually Program or Auto mode). Set the camera on the 

spot metering. Put the white balance on Daylight or Sunny. 

Zoom in to fill the viewfinder with the white card then take a 

picture. Don’t look at the LCD screen on the camera just yet. 

Put the black card over the white card so it’s in the same light. 

Again, fill the frame with the black card then make the photo. 

When you look at the monitor on the back of the camera, 

you know that you’ll have one photo of a white card and 

one of a black card, right? Well, check your camera’s monitor. 

What do you see? That’s right, two almost identical gray cards. 

What’s happening here? 

This composite of three images shows what reflected 

meters do. On the left is a white fabric panel. On the right is 

the black side of the same panel. Each of the two sides were 

exposed at the setting given by the camera’s built-in spot 

meter reading the area inside the red circles. They are both 

almost the same gray as the ColorChecker Grayscale balance 

card in the middle. The exposure for it was made with the spot 

meter setting on the camera centered on the gray patch. The 

card shows actual white and black on either side of the gray, 

so you can easily see how far off a reflected reading can be. 
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WHITE SHIRTS & BRIDAL GOWNS 
When shooting someone in a white shirt or a bridal gown, this is 

a problem. Huge. The photo will be underexposed by more than 

two stops. Not a good thing.

Here’s an example (below). The red circle in this image 

is the spot-reading point. The model’s blouse is gray as pre-

dicted. For the image on the right, I added 2 2/3 f-stops of 

light to get that blouse white with detail. Everything looks 

much better with the right amount of light. 

How does that right amount of light become the right 

amount? Guesswork? Nope. It’s really quite simple. Sort of.

Start with the reflected meter. We know it gives an expo-

sure that makes whatever it sees 12.5% gray. The correct 

exposure for white wants to be a little less than 100% reflec-

tance; 100% is white after all. The reflectance chart shows 

the difference between what the meter says and what the 

exposure wants to be. Shifting the 12.5% reading to almost 

white now makes sense. Add one stop of light and the reflec-

tance becomes twice as bright at 25%. (Adding one stop is 

two times more light, which doubles the reflectance.) Add 

another stop of light and the reflectance is now 50% because 

the amount of light has doubled again. Another full stop of 

light would be 100%, or pure white. There would be no detail 

in Catherine’s blouse. An increase of 2/3 of a stop is just right, 

pushing the reflectance to a little more than 80%. Perfect.

ONE SUBJECT, THREE EXPOSURES
A reflected reading overexposes the black card. Its reflectance wants 

to be somewhere between 1.5% and 3%, or two to three stops less 

exposure than the reflective reading. Here’s how reflective readings 

render a subject when reading a white card, a gray (12.5%) card, 

and a black card. The results (next page) are, from left, underex-

posed, correctly exposed, and overexposed. Note: The areas in the 

red circle that were read with the spot meter are all 12.5% gray. 

The reflectance chart can help unravel exposure issues. It 

interprets what the meter sees to what you actually want the 

photograph to be. It’s a good guide although not completely 

accurate. There’s another way.

INCIDENT METERING
It’s difficult to get the exposure right with the reflected meters in 

our cameras. They measure the light without being able to differ-

entiate whether a subject is bright, dark, or in-between. To get 

accurate exposures every time, measure light before it hits the sub-

ject. That’s what incident meters do. These meters have the little 

white dome. Best of all, most modern incident meters measure 

flash and ambient light separately or at the same time (bonus!).

Measuring the light that illuminates a subject eliminates the 

variables of reflectance. It seems obvious. When the amount of 

light to make an exposure is known, dark subjects are rendered 

dark and light ones appear light. Perfect.

There are two major players in the light meters for photog-

raphy field: Gossen and Sekonic, made in Germany and Japan, 

respectively. I have used both brands over the years, along 

with the venerable and, sadly, no-longer-available Minolta 

Flash Meters.

Fortunately, light meter 

science has progressed a lot. 

Since digital capture came 

on the scene, I’ve been using 

Sekonic’s L-758DR. I was an 

early adopter (serial number 

21). It can be calibrated to the 

sensor in the camera and it 

has a built-in PocketWizard 

transmitter for triggering elec-

tronic flashes wirelessly. This 

isn’t an endorsement of either brand; it’s an enthusiastic endorse-

ment of using incident metering to determine exposure. 

USING INCIDENT METERS
Walk up to the subject of the photograph. Point the dome of the 

incident meter at the source of illumination then take the reading. 

That’s it. Simple, right? I know you’re thinking, “It can’t be that 

easy. Nothing in photography is that simple.” For the most part, 

it really is that easy. Why? No matter how complex the lighting 

setup is, there’s always a primary source of light for the most 

important part of the photo. Measure that one light, then set 

that exposure reading on the camera. Every other light, and that 

includes reflectors, in the image functions in support of the expo-



› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 n
o

v
e

m
b

e
r

 2
0

14

088

L I G H T  I T  › ›

ALL IMAGES BY KEVIN AMES

sure for the primary source that’s set on the camera. The quality, 

color, and intensity of the other lights is a matter of the photog-

rapher’s vision, aesthetic, or simply taste.

SOURCE OF LIGHT
Jessica’s face is lit with a gridded Dynalite studio head in a 22" 

beauty dish (below). This is my source of illumination. This light 

is the one that I metered with the incident meter to get the 

exposure to set on the camera: 1/125 at f/11, ISO 100. With the 

exception of her face, Jessica is a silhouette. The photo on the left 

shows the high contrast between her body and the background. 

FILL LIGHT LOWERS CONTRAST
The only way to lower contrast is to add light to the shadows. The 

photo of Jessica on the right has much lower contrast thanks to a  

6' square Chimera light panel with a single Dynalite head behind 

it. This light is about a stop darker than the light from the gridded 

beauty dish. It’s the primary source of lowering the contrast. Its 

brightness is entirely my choice. It can even be brighter than the 

dish if I want it to be. How these lights are set and so forth is the 

exclusive decision of the photographer. The exposure still remains 

the same. My intention for this image was to have Jessica’s face 

be the brightest part of my photograph. The viewer will see her 

face first then look at her red St. John’s gown. The slightly darker 

background makes her stand 

out in its frame. 

The lighting is simple, as 

shown in the lighting dia-

gram for this shot. The expo-

sure is set for the amount of 

light from the beauty dish. Fill 

comes from the panel lit by 

the flash head behind it.

One more thing: When-

ever possible, I shoot tethered to my computer so exposure, 

color, composition, and focus can be monitored during the 

shoot. Nothing’s worse than returning from location only to 

find a problem that would have been easy to fix on the set. 

In the next issue, the “Dynamic Range” column covers the post-

production tactics for refining color and perfecting exposure. ■

Gossen Light Meters	 www.gossen-photo.us
Sekonic Light Meters	 www.sekonic.com
Dynalite Electronic Flash Systems	 www.dynalite.com
Chimera Light Modifiers	 www.chimeralighting.com

RESOURCES:

www.gossen-photo.us
www.sekonic.com
www.dynalite.com
www.chimeralighting.com
http://www.manfrotto.us
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2.� �LIGHTROOM DOESN’T HAVE  
PROJECTS LIKE APERTURE

In Aperture, the primary place you put your 

photos is called a Project. In Lightroom, it’s called 

a Folder. You’ll find the folders with all of your 

photos in the Folders panel on the left side in the 

Library module. Keep in mind, though, a Folder 

in Lightroom is very different from a Folder in 

Aperture (covered in #5 on the next page). 

1. �WHERE TO STORE  
YOUR PHOTOS

This is one of the biggest differ-

ences between Aperture and  

Lightroom. In Aperture, you 

have two choices for storing  

images: Referenced or Managed. 

The Referenced option leaves 

your photos where they are on 

your hard drives, and simply  

references them at that location. 

The Managed option sucks your 

images into the Aperture Library. 

It wasn’t a bad thing. In some  

ways it was a good thing, but 

a lot of photographers didn’t like not having direct access  

to their original files, even though they could always get  

to them if they needed to. 

Lightroom doesn’t have the Managed option. It only  

references your images where they are on your hard 

drive. When you import, you’ll see an Add option, which  

tells Lightroom to leave your photos where they are—

Lightroom won’t move them or do anything with them.  

It won’t lock them in some database that you can’t access.  

Lightroom simply makes its Library aware that your pho-

tos are there, and references them in the same place that 

you put them on your drive. Whenever you want access 

to your original image files, they’re exactly where you  

put them.

The writing was on the wall long before Apple confirmed 

it was stopping future development of Aperture. Aperture 

actually came out right around the same time as Lightroom 

(even a little before), but it was stagnant on version 3 for 

a long time, allowing Lightroom to continually pull ahead. 

Anyway, the debates over which is better don’t matter much 

now. If you’re an Aperture user, it’s time to find something  

else to manage and edit your photos. So if you’ve been waiting  

to make the jump to Lightroom, now’s your chance, especially 

with the $9.99/month Adobe Creative Cloud Photography 

plan becoming permanent.

	 If you’re thinking of switching, we have two ways to help 

you with the transition. First, Scott Kelby and I recorded  

a webcast (http://kelbyone.com/aperture-to-lightroom) 

on making the switch from Aperture to Lightroom. It’s totally  

free, and all you need to do is sign up.

	 Second is this article. If you’re an Aperture user, once 

you launch Lightroom you’ll notice there are many simi-

larities between the two applications, so rather than start 

from scratch and teach you every feature in Lightroom,  

I wanted to cover the top 10 things that you need to know if 

you decide to make the switch. Here goes!

3. �APERTURE ALBUMS= 
LIGHTROOM COLLECTIONS

If you use Aperture’s Albums feature, then you’ll 

be happy to know that Lightroom has something 

similar. They’re called Collections. They’re essen-

tially the same thing as an Album. As for where 

to find Collections, that’s the cool part—they’re 

everywhere. No matter what module you’re 

in, you’ll see the same Collections panel on the 

left side of the screen. (Not that it means any-

thing, but now that Aperture is gone, I really 

hope Lightroom changes the word “collection” 

to “album.” Album is actually the word I use to  

new users when trying to explain collections.)

BY MATT KLOSKOWSKI

9.99/month
http://kelbyone.com/aperture
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5. �AN APERTURE FOLDER  
IS SIMILAR TO A  
COLLECTION SET

Aperture has something called Folders 

that let you organize your Projects and 

Albums. For example, maybe you shot a 

wedding. In Aperture, you could create 

a Folder called “Smith Family Wedding,” 

and then include Projects or Albums 

under that to help you organize the 

photos from the wedding.

Lightroom has something similar.  

It’s called a Collection Set. Remember,  

a Collection is like an Album. Well, a 

Collection Set is a group (or folder) of 

Collections. So in Lightroom, you’d cre-

ate a Collection Set called “Smith Fam-

ily Wedding,” and inside that Collection 

Set, you’d put Collections (a.k.a. Albums) 

like Formals, Church, Reception, etc.

4. �APERTURE SMART ALBUMS= 
LIGHTROOM SMART COLLECTIONS

Just like Aperture had Smart Albums that automatically managed 

themselves based on certain criteria you define, Lightroom has 

Smart Collections. They’re in the Collections panel, and you just 

choose Create Smart Collection when you click on the New Collec-

tion icon (+) in the header of the Collections panel.

7. LIGHTROOM HAS PRESETS, TOO!
If you’re coming from Aperture and you loved your  

presets, this is probably one of the biggest upsides. 

While Aperture had a minor preset presence out there, 

you’ll find there are tons of Lightroom presets. The pre-

set market in Lightroom is much larger than Aperture’s.  

If you’re a preset junkie, head over to the Develop  

module and you’ll see the Presets panel on the left. 

Sadly, you can’t import your Aperture presets, but  

I happen to know a guy (who knows a guy) who has  

free presets on his site (http://lightroomkillertips 

.com/category/presets). 

6. WHERE’S THE LOUPE TOOL?
Okay, I’m not gonna lie on this one—I’ve always liked Aperture’s Loupe tool. It looked cool and made it easy to 

zoom in on the details in a photo. While Lightroom doesn’t have an exact replica of the Loupe tool, it does have 

the Navigator panel in the top left of the Library and Develop modules. If you click on the Navigator preview, 

the image zooms in and you can drag the little box around to see the details or zoomed-in view of your photo.  

I know it’s not the same, but it’s about as close as you’ll get (don’t shoot the messenger).

8. BASIC ADJUSTMENTS 101
Aperture and Lightroom share a lot of adjustment  

and slider names. For example, Exposure in Aperture 

does the same as Exposure in Lightroom, but there are 

some differences. In Aperture, the Exposure adjustment 

actually has a few settings. You’ve probably used the  

Enhance adjustment a lot, as well as the Highlights and  

Shadows adjustment. Each of those adjustments in 

Aperture has several sliders. In Lightroom, those adjust-

ments are known as panels. If you go to the Develop 

module, you’ll see the Basic panel, the Tone Curve panel, 

the Detail panel, etc. Once you go into a panel, you’ll 

see various sliders.

The main thing you need to know about the Basic 

panel (and most-used) adjustments is this: in Lightroom, 

the Basic panel is one of the most powerful panels. It 

contains a combination of controls that are comparable 

to the Exposure, Enhance, and Highlights/Shadows 

sections in Aperture. Here’s a quick list to help out:

Aperture Name	 Lightroom Name

Exposure	 Exposure

Recovery 	 Highlights (kinda)

Black Point	 Blacks

Brightness	� Exposure (we used to have  

Brightness but thankfully,  

it’s gone)

Contrast	 Contrast

Definition	 Clarity

Saturation/Vibrance	 Saturation/Vibrance

Highlights/Shadows	 Highlights/Shadows

Levels	 Blacks and Whites sliders

9. �Aperture Versions= 
Lightroom Virtual Copies

If you’re used to using Versions in Aperture, then you’ll 

be using the Virtual Copies feature in Lightroom. It lets 

you create a virtual version or copy of your photo. In 

the Develop module, go to the Photo>Create Virtual  

Copy menu option and now you’ll have a separate ver-

sion that’s totally independent of the original image file.

That’s it for my top 10 things that Aperture users need to 

know about Lightroom. I hope these resources help make 

the switch easier. If you want to learn even more about 

Lightroom and you’re a KelbyOne member, we have 

lots of Lightroom classes at http://kelbyone.com. Adobe, 

of course, has resources to help you make the transition, 

too. You can find those at http://kel.by/1rfkpjB. ■

10. �APERTURE TABS= 
LIGHTROOM MODULES

Getting around Aperture and Lightroom is a little  

different. Aperture favored what they call a modeless 

interface. You moved around more with tabs, but the 

interface remained pretty much the same throughout.  

In Lightroom, we use modules. They’re up top and you 

click on a module to go from one task to another (orga-

nizing, editing, creating books, etc.). When you switch 

modes (modules) in Lightroom, you’ll notice the set-

tings, panels, and sliders change based on what each 

module specializes in. 

ALL IMAGES BY MATT KLOSKOWSKI

http://kelbyone.com
http://kel.by/1rfkpjB
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Whether your aim is to correct a less-than-ideal expo-

sure or use the original image as the point of depar-

ture for creative explorations, the Develop module in 

Lightroom offers a wide range of very effective tools. 

But for photographers just starting out, or those who 

are new to Lightroom, all of those choices and options 

can sometimes be a bit confusing. 

 Finding the 
Processing
	 Path

B Y  S E Á N  D U G G A N

Where do you begin? What adjustments make the most 
sense for an image? Is there a particular order in which 
they should be applied? How do you find a processing path 
through the image that will both improve the file and fulfill 
your creative vision for the photograph? The answer to those 
questions can often be found in the image itself, as well as in 
where you want to take it.

two stages of processing
In my mind I think of image processing in two distinct stages. 
First are those adjustments that make improvements to the 
overall tonal, contrast, and color issues in the image. These 
are the type of modifications that are made to nearly every 
file, regardless of how I may choose to finally interpret it. Next 
come those modifications that are applied for more creative 
or interpretive results, and that are guided by how I want to 
present the image and the story it tells. 

evaluate the image
Before you make any adjustments to an image, no matter 
what software you’re using, the first thing to do is evaluate 
it. By identifying how it looks in its present state, and what 
aspects need attention, you can more easily chart a course 

through the different processing options that are available. 
The sliders in a software program are secondary. The image 
comes first. Evaluating it lets you name the problems it may 
have, and then make corrective adjustments with a purpose.

start with the fundamentals
When distilled to its core ingredients, a photograph is a col-
lection of tonal and color values that work together to cre-
ate the scene you photographed. Those basic ingredients 
are the brightness values (luminance), the contrast, and the 
color balance. 

In your evaluation, begin with those fundamental compo-
nents. How are the overall luminance levels? Is the photo too 
bright or too dark? Are tones that are supposed to be very 
dark or very light appearing that way, or do they need a little 
help to get them to where they need to be? 

Next, consider the contrast. Contrast is the difference 
between the brighter and darker tones. Is there too much 
contrast that results in highlights and shadows where detail is 
compromised? Is the contrast lacking, resulting in a dull and 
flat image?

Finally, what about the overall color balance? Is it too 
warm, too cool, or just right? Is there a noticeable color cast 
in areas that should be more neutral?

The basic image and an interpretation influenced by the  
volcanic nature of the landscape

Before

After
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the basic panel, for the basics
In terms of where to start in the Develop module, the Basic 
panel is the best place. It’s the first panel for a good reason: 
nearly all of the controls there affect the basic image ingre-
dients of luminance, contrast, and color balance. For many 
images, you can accomplish most of the overall processing 
objectives there. 

exposure, whites & blacks
First, adjust the Exposure slider to set the overall brightness 
level where you want it (see images below). Next, see how 
the endpoints (the very darkest and brightest tones) look. To 
adjust these, work with the Blacks and Whites sliders. If the 

Histogram tip: Move your mouse over different areas of 
the histogram and you’ll see distinct regions highlighted, as 
well as the settings for various sliders. You can also apply 
adjustments by clicking-and-dragging on different parts of 
the histogram. 

shadows and highlights
If the shadow tones, those tones that are slightly lighter than 
the very darkest areas, seem too dark, open them up a bit 
with the Shadows slider. Be careful about going too far with 
this adjustment because shadow values that get too light will 
reduce contrast, an important part of any photograph, as 
well as potentially reveal noise lurking in the shadows.

The Highlights slider allows for a similar modification to 
tones in the lighter regions of the scene. If the highlights 
seem a bit too bright and glaring, tone them down with 
this slider.

contrast
If there seems to be a lack of contrast in an image, the nice 
thing about adjusting the Whites and Blacks sliders is that 
this may do a lot to improve the contrast. If you feel that 
more is needed, you can use the Contrast slider, or if greater 
precision is required, use the Tone Curve panel. If you’d 
rather target tones in the actual image as opposed to mov-
ing the curve sliders, click the Target Adjustment tool icon 
in the upper left of the panel, and then drag up or down on 
a specific tonal region of the image to adjust those tones. 
When you’ve finished, be sure to click the icon again to turn 
off this feature.

the auto 
adjustment
The Auto button at 
the top of the Tone 
section in the Basic 
panel is designed to 
optimize the histo-
gram. Give it a try to 
see how it improves 
the image and pay 
attention to how it 
changes the histo-
gram, but don’t rely on it as a one-click adjustment intended 

darkest tones don’t seem dark enough, move the Blacks sider 
to the left and you can see the left side of the histogram 
shape move that way. If the darkest tones are too dark, move 
the Blacks slider to the right.

Adjusting the Whites slider to the right will have a similar 
effect on the brightest tones in the image, moving the right 
side of the histogram to the right and making those tones 
brighter. Moving it to the left will darken the brightest tones.

The important thing is to let the image be your guide. Set-
ting the endpoints can be a bit formulaic and, while it does 
improve many images, these adjustments may not be suitable 

for all photos. If the image doesn’t have very dark or bright 
tones (a scene photographed in heavy fog, for instance), then 
don’t force the adjustment; not all photos will have a total 
black or white tone in them. 

to fix everything. Consider it as an opening move just to get 
you started in the right direction. 

white balance
At the very top of the Basic panel are the white balance Temp 
and Tint sliders and preset menu, but that doesn’t mean  
I always adjust them first. Typically, I like to get the image’s 
overall tonal balance worked out first, so I’m more likely to 
adjust the Exposure and the endpoints before I fine-tune 
the white balance. This is especially true for images that are 
darker. I can be a much better judge if there are color balance 
issues in a photo once I have the overall brightness adjusted.

Keep in mind that while some color casts are undesirable 
and should be corrected, not all color casts are bad. The pres-
ence of a strong color cast may play a vital roll in establishing 
the mood or feeling associated with a particular image.

what about vibrance & saturation?
Image processing is subjective. We all have our personal tastes 
for how our images should look. For some photographs and 
some photographers, color saturation may be a vital ingredi-
ent in that look. As important as these controls are for fine-
tuning the flavor and character in an image, I view them as 
more interpretive adjustments to be made once I’ve estab-
lished the overall tonal and color balance in the scene.

first things first
Adjusting the basics of overall brightness, contrast, and color 
balance are essential modifications for any image. The exact 
nature of how you apply these adjustments will be deter-
mined by the individual image and its needs, as well as your 
own personal tastes. Once you’ve taken care of these, it’s 
time to focus more on the story of the image and how you 
want to tell it. 

working with the story of the image
Do all photographs tell stories? Perhaps not in the sense of 
a distinct narrative, but photographs do have something to 
tell and share. A photograph can portray a scene, show an 

Original
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aspect of someone’s personality, capture a significant instant 
in a story, or simply reveal a quiet and otherwise overlooked 
moment in time. The story of the image, what you want the 
viewer to see and how you want the viewer to experience it, 
should be your guide for the second stage of more creative 
and interpretive enhancements.

focus the viewer’s attention  
with light & shadow
There are many ways that we can influence the visual experi-
ence a person has as he or she looks at a photograph. First 
and foremost are how the image is composed, what it shows 
us, and the lighting in the scene. Beyond that, how you 
choose to process the file can be equally as effective in guid-
ing the viewer’s eye through the photo.

Use light and shadow to create a path for the eye to follow 
in the image. Darkening unimportant areas can make them 
less prominent and move them more into the background. 
Lightening significant areas in the photo creates paths for the 
eye to wander along. The most obvious way this has been 
done for many years is the practice of burning in the edges of 
an image. Darkening the outer areas casts a virtual spotlight 
on the center (see below).

The local adjustment tools such as the Graduated Filter (M) 
and Radial Filter (Shift-M), as well as the Adjustment Brush (K), 
are the primary ways to use light sculpting to emphasize some 
areas while diminishing the importance of others.

ALL IMAGES BY SEÁN DUGGAN

finding the path
By first evaluating an image to identify how it looks, it 
becomes easier to determine what fundamental adjustments 
it may require to bring the photo into a basic state of tonal, 
contrast, and color balance. Once these essential components 
have been improved, you can use the story of the image to 
guide you in establishing an overall mood and feeling for the 

scene. Local adjustments are the final step, allowing you to 
use light and shadow to help guide the viewer’s eye through 
the image. ■

http://kelbyone.com
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Under 
the 

Loupe
One of the main reasons we use Lightroom is that it makes our 

entire digital workflow so much more efficient than using a com-

bination of other tools. A key to getting the most out of Lightroom 

is to gain mastery over all of the various types of templates that 

you can employ at different points in your workflow.

workflow template mastery
B Y  R O B  S Y L V A N

A template (or preset) is essentially a glorified text file that allows 

you to save some set of information that you can call into use 

over and over again, which is much faster than re-creating or 

entering that information each time you perform a given task. 

(Note: Lightroom uses the words “template” and “preset” 

somewhat interchangeably, but I try to use the term shown in 

the interface where applicable.) The types of templates I’m talk-

ing about appear all over in Lightroom, and some in more than 

one place. Specifically, I’m referring to filename templates, meta-

data templates, import templates, and text templates, which  

I like to think of as workflow templates. There are also layout 

type templates, such as those found in the Web, Print, and Slide-

show modules, but I’ll save those for another time. I want to 

focus on helping you understand the ins and outs of creating and 

managing these workflow-type templates.

We’ll start with the first place in your workflow: the Import 

dialog. The Import dialog is a multitasker’s dream, as its main 

purpose is to add photos to the catalog and then frontload the 

entire process by facilitating such jobs as renaming the photos 

(using a filename template), adding core metadata (from a meta-

data template), applying keywords, and even applying a Develop 

preset. You can then save all those settings in an Import preset to 

easily reconfigure the settings in the future with a click. 

filename templates
One of the most commonly used templates are filename tem-

plates. There comes a time in every Lightroom user’s workflow 

when photos need to be renamed, whether during import, after 

import, or during export. The filename templates you create can 

be accessed and used no matter when you’re doing the renam-

ing. On the Import dialog, you can find them in the aptly named 

File Renaming panel. (Note: You won’t see the File Renaming 

panel if you choose to Add files to the catalog instead of copying 

or moving them.) Lightroom comes with a few filename tem-

plates installed, and that’s fine, but you can easily create your 

own with the Filename Template Editor. Here’s how:

step one: Check the 

Rename Files box, then 

click the Template drop-

down menu and choose 

Edit. This opens the edi-

tor with the tokens used  

in the active template be-

ing displayed.

step two: Clear the existing tokens from the entry field to 

start fresh, and then create your own template using any com-

bination of tokens that suits your needs. You can also type text 

right into that field, which is handy for separating tokens with 

hyphens or underscores. 

step three: Once you’ve assembled the tokens in the de-

sired format, click the Preset drop-down menu and choose Save 

Current Settings as New Preset, enter a meaningful name, click 

Create in the New Preset dialog, and then click Done in the File-

name Template Editor to finish the process.

You might have different file naming requirements for different 

jobs, so you can take the time to create as many filename tem-

plates as you wish. The least intuitive part of the process is delet-

ing unwanted presets, but it’s easy once you know how (and 

it works the same way with all other templates we’re going to 

cover). To delete a filename template, click the Preset drop-down 

menu in the Editor and choose the one you want to delete. Then, 

click the Preset drop-down menu a second time and choose 

Delete Preset “[preset name]” to remove it for good. There’s also 

the option to rename the template, too.
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When importing files, select the appropriate template in the 

File Renaming panel. If there are any custom fields that need to 

be filled in, they will appear in the panel.

metadata template
Another template you should be taking advantage of right from 

the start is the metadata template. At the most basic level, the 

metadata template allows you to apply important copyright and 

contact information into the metadata of every photo as part 

of the import process. In the Import dialog, expand the Apply 

During Import panel, click the Metadata drop-down menu, and 

choose Edit Presets to open the Edit Metadata Presets editor. 

At a bare minimum, I recommend filling out the IPTC Copyright 

section and as many of the IPTC Creator fields as you feel comfort-

able with to assist people with contacting you should they find 

one of your images in the wild. I like to fill out the phone (using 

a Google Voice number), email, and website fields. Keep in mind 

that any field that has a checkmark will be included in the preset. 

If the checked field is empty it will simply wipe that field on every 

incoming photo and leave it blank (I have a template I sometimes 

use to wipe any existing keywords from photos during import). To 

save your metadata template, click that Preset drop-down menu 

and choose Save Current Settings as New Preset. Like the filename 

templates mentioned earlier, you can delete, rename, and update 

templates the same exact way with that drop-down menu.

import preset
Now most of the settings on the Import dialog are sticky, mean-

ing that once you’ve had a successful import, those settings will 

remain configured the same way the next time you do an import. 

However, if you’re in the habit of changing certain settings based 

on your workflow needs, you would benefit from preserving 

your core settings in an Import preset. The Import Preset menu 

can be hard to spot. It’s located on the bottom of the Import 

dialog in the center of the screen. Once you’ve configured the 

Import dialog the way you want it, click the Import Preset drop-

down menu and choose Save Current Settings as New Preset (are 

you detecting a pattern yet?), and give it a meaningful name. 

Deleting these presets involves the same process of selecting 

the desired preset from the drop-down menu, then clicking the 

menu a second time to access the delete option.

Keep in mind that once you’re through the import process, you 

can always batch rename photos by selecting the photos while in 

Grid view (G) of the Library module, and going to Library>Rename 

Photos menu. You’ll have access to the same set of filename tem-

plates, as well as the Filename Template editor. Likewise, if you 

need to go back and batch apply your new metadata template to 

previously imported photos, you can also do that from Grid view by 

selecting all photos and choosing your metadata preset from the 

Preset drop-down menu located at the top of the Metadata panel.

text templates
You may not have call to use these as often as the other tem-

plates mentioned, but file it away for when it will come in handy. 

In each of the output modules—Book, Slideshow, Print, and 

Web—there’s a way to leverage the power of the Lightroom 

database to automate the insertion of text into your project. 

For example, let’s say you go through the trouble of applying 

a caption to each photo via the Caption field of the Metadata 

panel. You have that data in the catalog, so now you can use a 

text template to pull that data from each photo’s metadata and 

display it in a slide show, on a print, in your Web gallery, or in 

a book. Let’s look at the most common example I come across, 

which is displaying a unique caption in a slide show.

step one: Start by entering descriptive captions in the Cap-

tion field of the Metadata panel for each photo in the slide show. 

step two: Switch to the Slideshow module, then click  

the ABC button on the Toolbar to add a Text Overlay to the  

slide show.

step three: Click the drop-down menu next to Custom Text 

(below) and choose the Caption template that comes with Light-

room. This tells Lightroom to pull the caption from each photo 

and display it within that text overlay. 

step four: Reposition and resize the text overlay as desired 

to fit your needs.

To open the editor to create your own custom text templates, 

choose Edit from the bottom of the drop-down menu. You’ll 

notice that the Text Template Editor looks and works in a very 

similar fashion to the Filename Template Editor we saw earlier. 

You can mix and match tokens, and even type directly into the 

editor to create all manner of templates.

Beyond the Slideshow module, text templates (and the edi-

tor) can be accessed in the Page panel of the Print module when 

using the Single Image/Contact Sheet layout style, the Image Info 

panel of the Web module, and the Text panel of the Book mod-

ule. The ability to format text is quite limited in some modules, 

so keep that in mind.

To find where all of your templates and presets are stored so 

you can ensure they are included in your regular backup, go 

to Lightroom (PC: Edit)>Preferences, click on the Presets tab, 

and click the Show Lightroom Presets Folder button. This will 

open Finder (PC: Windows Explorer) with the Lightroom folder 

selected. Inside the Lightroom folder is where you’ll find all of 

the template files organized in clearly named folders. You can 

delete templates right from their respective folders to remove 

unused ones quickly, or even place new templates you’ve 

downloaded from other sources to add them (restart Lightroom 

to see the changes). ■

ALL IMAGES BY ROB SYLVAN
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Tonality Pro is a new application by Macphun for 

creating stunning monochrome photographs. It 

works as a standalone application, as well as a 

plug-in for Photoshop and Lightroom. It also sup-

ports 16-bit RAW files so there’s no loss of fidel-

ity. As the name of the company implies, this is 

Mac-only software. This article will focus on the 

Lightroom plug-in, which is part of the Pro version 

of Tonality available from the Macphun website. 

tonality proMaximum 
Workflow 

B Y  C O L I N  S M I T H

install and access the application
To install the Lightroom plug-in, first download and install the 

15-day free trial of Tonality Pro from www.macphun.com. 

Launch Tonality Pro and open an image. You’ll get a message 

dialog stating, “To install Tonality Pro as plug-in the system needs 

to locate supported software.” Click OK. In the resulting dialog, 

click the Install button next to Lightroom, and then click Done. 

If you ever need to get back to the install dialog, choose Tonal-

ity Pro (PC: Edit)>Install Plug-ins. Tonality Pro will be installed as 

a Lightroom plug-in with all the functionality that it brings. The 

Tonality Pro plug-in can be found where all plug-ins live in Light-

room: Photo>Edit In>Tonality Pro. Click the Edit button to launch 

the Tonality Pro interface.

tonality pro interface
The interface is easy to figure out. At the top middle, you’ll find 

all the viewing options, then on the top right, you’ll see four tools: 

Move Mode, Brush Mode, Erase Mask, and Gradient tool (for 

masks). You’ll also notice an icon that’s used to toggle the histo-

gram on and off. I want to mention the histogram here because 

it has a very unique feature. When you roll over the histogram, 

you’ll see a bar across the bottom that’s actually the 10-zone sys-

tem. If you roll over any of the numbered zones, an overlay will 

appear in the photograph. Different zones can be turned on and 

off by clicking on the numbered squares in the histogram.

layers and masks
Before we look at the different 

effects and adjustments that 

are available, it’s worth men-

tioning one of the strengths 

of Tonality Pro. You can effec-

tively target different parts of 

an image with different effects 

using layers and masks. You 

can add up to eight layers, including the original layer. These lay-

ers have different blend modes available (Right-click on a layer, 

go to Blend, and select the desired blend mode). Each layer also 

has an opacity slider for fine control.

The layers can easily be controlled by the use of masks. When 

you create a layer and make adjustments to it, you can alter the 

mask in one of two ways: gradual changes across the image 

using the Gradient tool, and targeted adjustments using either 

the Brush Mode tool or Erase Mask tool. Begin painting with 

the Erase Mask tool to hide adjustments. The other option is the 

Brush Mode tool. In a stroke (excuse the pun) of genius, you 

don’t have to mask out the layer before you begin painting with 

the Brush Mode tool; it automatically hides the adjustment from 

the entire layer except where you paint.

I often break up different types of adjustments onto their own 

layers. I like to do tone adjustments on one layer, special effects 

on another layer, and any color effects on the top layer. I’m a big 

fan of layers and masks for things such as skies and faces, which 

generally look better with their own adjustments.

presets
Another strength of Tonality 

Pro is the abundance of pre-

sets. Out of the box it comes 

with more than 150 different 

styles, divided into 10 catego-

ries. These categories include 

Dramatic, Vintage, Film Emu-

lation, Portrait, HDR, and more to provide plenty of options. 

It’s a good idea to start with a preset and then make some 

tweaks to suit your individual photograph and tastes. It’s also 

easy to tweak presets because Tonality comes with a brilliant fea-

ture. If a panel has an adjustment that was used for a particular 

preset, that panel’s name appears in yellow, and every slider that 

has been changed has a yellow strip on it that leads back to its 

default position. 

When a preset is applied, there’s 

a slider in the preset thumbnail that 

appears when you hover your cur-

sor over the thumbnail. The slider 

allows you to adjust the amount 

of the effect that’s applied to the 

image. If you want to add other 

effects to the image, I suggest doing 

it on a different layer so you can 

adjust the opacity of those adjust-

ments independently of the preset.

Of course, you can also make 

your own presets and share them 

with others. Just click the Create 

button in the Presets panel. 

the tone panel
Typically speaking, the Tone panel 

is the place where you should 

www.macphun.com
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begin, and the real power of Tonality Pro is in this panel and the 

Clarity & Structure panel. The Tone panel should look familiar to 

you; it’s similar to the Lightroom adjustments in the Basic panel. 

But look closely; you’ll see two options that won’t be so familiar: 

Adaptive Exposure and Smart Contrast. If these two sliders were 

the only features in Tonality Pro, I would be satisfied.

Unlike the Standard Exposure and Contrast, these two 

options allow you to change the tonality of your image with-

out losing detail by blowing out the highlights or plugging up 

shadows. Adaptive Exposure allows you to brighten or darken 

the pixels in the image while maintaining highlight and shadow 

detail. It’s really quite impressive. Smart Contrast allows you 

to bring out the hidden detail in the shadows and highlights 

(recover dynamic range).

the clarity & structure panel
The Clarity & Structure panel is where you bring out the details 

in a photograph. Use the Clarity slider to boost the midtone 

contrast. It works very similar to the much-loved Clarity slider 

in Lightroom. Use the Structure and Micro Structure sliders to 

boost the detail and bring out textures in an image. These work 

exceptionally well to bring back the cloud detail in skies. Use the 

Protection sliders to reduce the amount of noise that can also 

be unwittingly brought out. The Structure tools are a favorite 

of mine to bring out the details that would be otherwise lost in 

aerial photography. 

the tone curve panel
The Tone Curve works like the curves in Lightroom, allowing you 

to target precise tones to be adjusted. 

special effects
The next section of tools is more what I would call special effects. 

Because of space, I can’t get into as much detail as I would like 

for each panel; however, I’ll tell you what each one does. 

Split Toning: Split Toning works just like the split toning in 

Lightroom. This allows you to add a colored tint to the shad-

ows and highlights independently, creating a duotone style 

of color. 

Glow: The Glow panel is a 

good option for adding a 

glamorous look to a portrait. 

You choose the Amount of 

glow, and then fine-tune 

it with the Smooth and 

Threshold sliders. Move the 

Smooth slider to the right to 

increase the amount of blur, 

and move the Threshold 

slider to the right to allow 

the glow to be applied to 

more of the image. 

A word of caution here: These sliders are powerful and it’s 

easy to make your images look overprocessed. So, remember 

a little bit goes a long way. Avoid the trap of making too many 

adjustments just because you can.

the color filter panel
When you’re converting a color photo to black and white, its fla-

vor can be dramatically changed by the way you map the colors 

to different grayscale tones. Have you ever used a Black & White 

adjustment layer in Photoshop to convert to black and white? 

You can drag a certain color slider to make all those regions 

brighter or darker. For example, the Blues slider can make the 

sky very light or dark in the black-and-white version. This allows 

you to add emphasis to any part of the photograph that you like.

The Color Filter panel is where you do this in Tonality Pro. 

Choose the Luminance option and drag the different color sliders 

to see how each color influences the final black-and-white ver-

sion. The rectangles at the top of the panel are presets that push 

the image toward specific colors. Click on the different rectangles 

until you see the option that you like best, then move the individ-

ual sliders to tweak it for your image. You might have to go back 

and fine-tune the Tone panel sliders after you’ve set this option.

The Saturation sliders are unique and can produce some 

interesting results. If you drag any of the sliders to the right, the 

underlying colors will be restored in the image. This is fun if you 

want to have a photograph where certain colors are showing 

and everything else is black and white. You can restore all the 

color in the photograph by moving all the sliders to the right, 

which means you can now use Tonality Pro on your color images, 

or drop out only one or two colors. Hint: If you’re going to do 

this, you can save time by turning on the color only and saving it 

as a starting point preset. 
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Lens Blur: With all the detail that you can pull, it’s easy to make a 

photograph look too busy. The Lens Blur is really useful for adding 

depth-of-field effects that simulate shooting with a large aperture. 

This is especially useful for blurring out distractions and focusing 

the viewer’s eye on a portion of the photograph.

Texture Overlay (right): You can add texture overlays from three 

different categories: Paper, Metal, and Film. There are a number 

of blend modes that you can select to make the textures blend 

in different ways. You can also apply your own textures via the 

Load Custom Texture option.

Vignette: The ever-popular vignette is here to either darken or 

lighten the edges of a photo. You can also place it wherever you 

like in the image, so it doesn’t have to be in the center. 

Grain: Add filmlike grain—no more explanation is needed here. 

Photo Frames (below): The frames are a lot of fun. There are a 

number of different frame styles that you can apply to finish your 

images. They can also be adjusted by moving the Width slider. 

As you can see, Tonality Pro is a unique plug-in that extends the 

functionality of Lightroom and allows you to easily do things that 

you couldn’t before. Happy creative explorations! ■
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there are publish modules 
for Behance, Facebook, and 
Flickr, and publish plug-ins can 
be installed for other services. 
Some are free, while others by 
independent developers are 

available for purchase at cre-

ative.adobe.com/addons.
Click Set Up on a Publish Service to configure it. Many of the 

options in the Lightroom Publishing Manager, such as Image 
Sizing, Output Sharpening, and Watermarking, are the same as 
those you find in the Export dialog. Essentially, the Publish Ser-
vices are just another way to export your images.

The convenience of using the Publish Services is that it cre-
ates a collection that is specific to that online account. You can 
add images to the publish collection by dragging them onto the 
collection name, and can then publish to the online site when 
you’re ready. If you modify an image, you can choose to repub-
lish it and it will update the version that is hosted on the photo 
sharing site. You can even monitor and reply to comments on 
the image in the Comments panel in the Library module.

publish to a hard drive
At the top of the list of Publish Services, you’ll find Hard Drive 
listed. This is an incredibly useful way to target a location on 
your local hard drive and export images to this folder. Light-
room will keep track of the images you publish there. If you 
update any of them in Lightroom—either by making changes 
in the Develop module, or by changing metadata such as key-
words—you can republish them to the same location. This 
provides an easy way to make sure that the images in a given 
location are always up to date. Using the Publish Services for 
images that are published online is certainly a big plus, and if 
you haven’t yet tried it, I encourage you to take it for a spin.  
I also find the ability to publish to a hard drive location, and keep 
those exported images up to date with any changes to the mas-
ter file, very handy. ■

Lightroom provides a number of ways to manage files that you 
export from the catalog, either as completely new files, or as 
files that are published to online photo sharing services. In this 
column, we’ll take a look at ways you can streamline this pro-
cess and keep track of exported images.

There are two main ways you can export images: the Export 
dialog, which will create a new file with all Lightroom adjust-
ments applied to it, and the Publish Services, which will export 
a file directly to an online destination, such as Facebook, Flickr, 
Behance, SmugMug, or other sites.

save export presets
If you need to export files for a specific purpose on a regular 
basis, then save an export preset. After configuring the settings 
in the Export dialog, click the Add button in the lower left to 
save a preset of those settings. This preset can be accessed in 
the Export dialog, but also, and more conveniently, by Right-
clicking on a group of selected images in the Library module. 
From the contextual menu that appears, choose Export, and 
then find the correct preset.

use consistent folder locations 
If you’re exporting for specific purposes, like images for your 
website, blog, or self-promotion, create folders for each of these 
on your hard drive and make sure the correct folder is chosen in 
the Export dialog before you create an export preset.

add exported files to the catalog
In the top section of the Export dialog, there’s an option to add 
the exported files back into the current catalog. I typically do 
not use this because I already have the original images (usu-
ally improved with Develop module edits) in the catalog. But 
for some workflows it may be handy to add the exported files 
back to the catalog if you want to keep track of them this way. 
If you do this, be certain that you do so using a folder structure 
for the exported files that makes sense for your catalog. And, 
most importantly, don’t change the folder names or move them 
using the Mac Finder or Windows Explorer. Any folder name or 
location changes should be handled in Lightroom.

using publish services
If your aim to is upload photos to an online destination, consider 
using the Publish Services panel. In the default configuration, 

SEÁN DUGGAN

ADOBE PHOTOSHOP   Lightroom Section ›  ›

& TipsTricks

creative.adobe.com/addons
creative.adobe.com/addons
http://kelbyone.com/books/
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In this type of portrait, the planning of the setup and shots is just  
as important—or perhaps more important—as the postproduction. 
Rather than relying too much on the retouching tools in Photoshop, 
we’re going to try to make our task in Photoshop a little easier by the 
way we take the photos.

D Y N A M I C  R A N G E  › ›

K E Y  C O N C E P T S  › › Healing and Spot Healing Brush tools

Clone Stamp toolLayer masks

The end result I’m aiming for is a fun portrait of a girl whose music 
is so loud that it bounced her right out of her chair. At least that’s 
the look I want to end up with, by taking a bunch of photos and 
combining them to create this image. Let’s walk through the pro-
cess, including what worked well and what I learned for next time.

P H O T O G R A P H I C

B Y

D A V E  C R O S S

Before
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POSTPR■ODUCTION  
PREPARATION
After you have all of your captures, review your images in 
Bridge to identify the ones you want to use. In many cases, 
especially for the images that included the model, I initially 
made a few choices and then narrowed it down. USE STAR 
RATINGS TO START AND THEN LABELS TO NARROW IT DOWN 
TO YOUR FINAL CHOICES. 

To ensure that the settings are the same on all 
images, open one of the images with your main subject 
in Camera Raw (press Command-R [PC: Ctrl-R] while 
in Bridge) and make some adjustments. Rather than 
opening the image in Photoshop when finished, click 
Done to return to Bridge. That way, you can SELECT 
ALL THE REMAINING IMAGES IN BRIDGE, RIGHT-CLICK ON 
ONE OF THE SELECTED IMAGES, AND CHOOSE DEVELOP 
SETTINGS>PREVIOUS CONVERSION to apply the same 
settings to all the images. (Needless to say, you could 
use Lightroom for this part of the process.) 

To get all the chosen images into one document, 
select them in Bridge, and from the Tools menu, chose 
Photoshop>Load Files into Photoshop Layers. That cre-
ates a new document with each of the selected images 
on its own layer.

Even though you used a tripod, you’ll still want to 
make sure that all the photos perfectly line up. To do 
this, select all the layers in the Layers panel, and from 
the Edit menu, CHOSE AUTO-ALIGN LAYERS, PICK THE 
AUTO OPTION in the resulting dialog, and click OK.

EDITING T■HE LAYERS
The layer with your model or main subject is the key layer 
that you’ll want to work on, so position the other layers 
(the ones without fishing wire, blocks of wood, etc.) under-
neath that layer in the Layers panel. With the model layer 
active, click the Add Layer Mask icon (circle in a square) at 
the bottom of the Layers panel and START MASKING THE 
LAYER SO THAT THE CLEAN LAYERS BELOW START TO SHOW 
THROUGH. To do this, use a combination of painting on the 
mask with the Brush tool (B) set to black (press D then X) 
with a hard-edged brush and using your favorite selection 
tools to make selections on the mask and filling them with 
black (Option-Delete [PC: Alt-Backspace]). 

Your goal here is to remove all the larger support ele-
ments using this masking to reveal the layers below. IN A 
FEW CASES, I NEEDED TO ADD A SMALL AMOUNT OF CLON-
ING with the Clone Stamp tool (S) to clean up edges and 
add to the realism.

Here’s an example of why it was so important to HAVE 
AN IMAGE WITHOUT ANY WIRES: there were several wires 
going across the poster of the five good-looking men 
she has in her room. 

Imagine how hard it would be to CLONE/HEAL/PATCH 
OVER THESE WIRES WHILE PRESERVING ALL THE GRAPHICS 
in the poster. Instead, on the layer without wires, I made 
a selection of the poster and some of the surrounding 
wall and duplicated that selection onto a new layer  
by pressing Command-J (PC: Ctrl-J).

PLAN■NING AHEAD
Here was the thought process for setting up the shots: If 
there’s one shot with an element suspended on fishing line, 
there should be a shot without that fishing line. START WITH 
EVERYTHING IN THE SHOT WITHOUT THE MODEL, add the 
model, and then gradually remove elements.

I used a fairly simple setup in my studio with all the 
ELEMENTS THAT WILL BE FLOATING EITHER SUSPENDED ON 
FISHING LINE, or placed on top of something that will 
eventually be removed. For example, shots were taken 
with the small table on the right sitting on top of an 
apple crate. The apple crate was later removed, leaving a 
shot of only the wall behind and carpet underneath. This 
will make things easier later on.

THE SH■OOT
Before putting the model into the set, set up your camera 
on a tripod, FIND THE BEST ANGLE FOR YOUR LIGHTS, AND 
LOCK DOWN THE TRIPOD so there’s as little movement as 
possible between shots. Then, take a few shots with every-
thing (except the model).

Here’s the first example of what I’d do differently 
next time: Several elements were hung to appear as if 
they were floating around and behind the model, but 
I DIDN’T THINK ABOUT THEIR POSITION RELATIVE TO HER 
BEING IN THE SHOT. For example, you can see objects 
on the bench, a suspended book, and a teddy bear 
in the shot above. But when the model was brought  
in, they were effectively covered up, so next time  
I would have her sit in while adjusting the height of the 
other elements.

Next, the model was brought in, after having 
described to her the desired final effect. I took quite a 
few shots with her balancing on the steps, and then real-
ized it would look even better if her hair was blowing 
from the sound coming from the speakers. ALTHOUGH 
IT DID ADD A NICE EFFECT TO HER HAIR, EVERYTHING THAT 
WAS SUSPENDED ALSO STARTED MOVING AROUND—THAT 
WAS BOTH GOOD AND NOT SO GOOD. The shutters on the 
window moved a bit and that looked very cool, but the 
skateboard helmet and one of the toys kept spinning in 
the breeze and it was hard to get those elements posi-
tioned just right. 

After a few minutes and a good selection of model 
shots from which to choose, the model stepped out. 
ANOTHER SERIES OF SHOTS WAS TAKEN AS THE HANGING 
ELEMENTS WERE MOVED OUT OF THE FRAME. 

You may also want to have shots of the tilted furni-
ture without the things that are holding them up, so use 
the self-timer on your camera, remove the supports, and 
hold each piece in (roughly) the same position. THIS WILL 
GIVE YOU AN IMAGE THAT DOESN’T CONTAIN THE SUPPORT 
BUT WILL INCLUDE ANY NATURAL SHADOWS.

Here’s another thing I would add next time: TAKE 
SHOTS WITH EVERYTHING REMOVED, RIGHT DOWN TO  
THE CARPET AND WALLS. During the editing process, 
there were a couple of times when an image of only 
the carpet would have helped to eliminate fishing  
line, etc.
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After positioning the copied layer higher in the layer 
stack than the main image layer, I added a layer mask 
to blend it in a little better. That simple process saved a 
ton of time, and very clearly ILLUSTRATES THE CONCEPT 
OF HAVING CLEAN LAYERS with which to work.

In some cases, it was just as easy to add a blank layer 
and use the Spot Healing Brush tool (J) or Patch tool 
(nested under the Spot Healing Brush) to cover areas up. 
This was particularly the case in areas where certain ele-
ments weren’t in exactly the same position in each layer 
because of the blowing fan. To do this, add a blank layer 
at the top of the stack, switch to either the Spot Healing 
Brush or Patch tool, and make sure that Sample All Lay-
ers is checked in the Options Bar. This puts the results of 
the retouching tools onto a blank layer, making it easier 
to tweak the results if needed. Also, make sure to choose 
the Content-Aware option for both tools, as that dra-
matically improves the results.

To cover up some of the obvious fishing wire that was 
in front of the wall, I EMPLOYED THIS USEFUL TECHNIQUE 
WITH THE SPOT HEALING BRUSH: after choosing a brush size 
that’s slightly larger than the wire, paint a straight line. This 
is done by clicking once where you want the line to start, 
then holding down Shift and clicking a second time at the 
end of the line. This will paint a straight line with the Spot 
Healing Brush and will often heal over everything in one 
shot. Remember to use that Sample All Layers option so it’s 
easier to edit the healing layer, if necessary.

As I masked out of the steps from under the model,  
I realized that her behind looked a little flat from sitting. 
I made a selection of that area, duplicated it onto its 
own layer, and used Filter>Liquify to round it out a bit. 
Two important notes here: BEFORE APPLYING THE LIQUIFY 
FILTER, CONVERT THE LAYER TO A SMART OBJECT (FILTER> 
CONVERT FOR SMART FILTERS) SO YOU HAVE AN EDITABLE 
SMART FILTER; and in Liquify, check the Show Backdrop 
option to edit the layer in the context of the background. 
After clicking OK in the Liquify filter I expected to have 
to do a little masking to make the two layers blend 
together, but happily, that wasn’t necessary. 

There was also AN UNEXPECTED ISSUE WITH THE BEAN-
BAG CHAIR. The beanbag chair was included in the orig-
inal setup before the model was in the shot; however,  
I didn’t look at the height of the beanbag chair rela-
tive to the steps the model was going to be sitting on. 
If I had, I would have realized that the beanbag chair 
should have been a little lower to create air between the 
model and the chair. As a result, I had to select and copy 
the beanbag chair onto its own layer, and then use Free 
Transform (Command-T [PC: Ctrl-T]) to lower the height 
of the chair. Luckily, I had taken a couple of shots with-
out the model or the beanbag chair, so it was relatively 
easy to do this (although not a step I had planned on).

I’m pretty happy with the end result, considering this was 
the first time I had tried this kind of levitation project. As 
with most photography projects, I MADE NOTES FOR NEXT 
TIME TO IMPROVE THE PROCESS, the most important of 
which would be to have the model sit in while you position 
your props, and to gradually remove every element on the 
photo as you take your photos so that you have lots of clean 
layers from which to choose as you start editing. It was defi-
nitely a fun project and I can’t wait to try something like 
this again. ■

All Images by Dave Cross

http://www.bhphotovideo.com
http://kelbyone.com/discounts/
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K E Y  C O N C E P T S  › › Clone Stamp tool Type tool

Step One

Step Two

Step Four

There are some quirks 

in this tutorial, so be 

patient and take notes. 

(Note: If you need to 

catch up on Clone 

Stamp basics, KelbyOne 

subscribers can check 

out RC’s tutorial at 

http://kelbyone.com/

player/rc_cloneand-

heal.) We’re going to 

sample from one docu-

ment while painting in another; to make things easy, use two 

documents of the same size. Portrait.PSD (available from www 

.dollarphotoclub.com) is my source document, and the blank 

target document has a white Background layer with a blank layer 

above that. I’m using the separate source document to demon-

strate building up an image by painting.

Step One: Select the Clone Stamp tool (S) and open the Brush 

Presets panel (Window>Brush Presets), then choose a Scatter or 

Bristle brush tip—I used Scattered Leaves from the Brush Pre-

sets panel, but anything will work. In the Options Bar at the 

top, set the tool Opacity to 50%. Now show the Clone Source 

panel (Window>Clone Source). In this panel, click the far left 

Clone Source icon at the top, then set everything as shown in 

the screen shot, including 60% Opacity for the Overlay. In the 

Options Bar, deselect the Aligned checkbox and ensure the Sam-

ple drop-down menu is set to Current Layer. Select a relatively 

small brush size (the default size of 95 pixels was used in this 

example). Take a moment to name the image layer in the source 

document something meaningful, like “Portrait.”

Step Two: In the source document with the Clone Stamp tool 

active, Option-click (PC: Alt-click) on an area of interest, like a per-

son’s eye. This will be the starting point for painting in the target 

document. At this point, you should be able to faintly see the sam-

ple you clicked on in your brush shape. In the target document’s 

SCOTT VALENTINE

Most of you know how to use the Clone Stamp tool, and probably the Clone Source panel, as well. Behind the 
scenes, the Clone Stamp samples an area of your image and copies what it samples to wherever you paint on 
your canvas—not much mystery there. This issue, I’m going to skip the basics and leave the under-the-hood 
approach aside in favor of showing you an unusual technique for these essential retouching tools.

Photoshop Proving Ground 
 clone stamp tricks

blank layer make a single paint stroke where you want her eye 

to appear. Now go up to the Options Bar and select the Aligned 

checkbox. This locks the starting point and aligns everything so you 

can continue painting as if you were revealing from a mask—very 

important if you paint with lower opacity to build up the image. At 

this point, you can continue painting and building up.

If you hadn’t checked the Aligned box, you would be starting 

over with her eye every time you released the mouse button (or 

picked up your pen if you’re using a tablet). That would result in 

eyeballs stamped all over. Creepy!

Step Three: Now that we’re warmed up, let’s get fancy. In the 

target document, turn off the layer you just painted by clicking 

on its Eye icon in the Layers panel and create a new, blank layer 

above that. In the Clone Source panel, note that the name of 

your source document and the layer appear near the top, just 

under the source icons or as you hover over the icons—a good 

reason to name your layers all the time.

You can load up to five sources from up to five open docu-

ments (they all have to stay open while you’re using them), load 

multiple sources from the same document, or any combination. 

You also can load samples from different layers of the same 

document. Each sample can have different attributes from the 

Offset section of the panel—rotation, reflected, or offset. And in 

the Options Bar at the top of your workspace, the layer selections 

of Current Layer, Current & Below, and All Layers is persistent for 

each sample. How very cool is that? All of this means you have 

tons of flexibility in choosing and painting with your sources.

Step Four: In my source document, I’ve added a text layer and 

named it “Words.” I’ve also applied a Drop Shadow layer style to 

the text to give it some glow (Layer>Layer Style>Drop Shadow). 

In the Options Bar for the Clone Stamp tool, enable Aligned 

because this time we want the image placement in the target 

document to match the source image.

Step Five: In the Clone Source panel, click the second Clone 

Source icon at the top. Ensure the top Words layer with text is 

active, then hold Option (PC: Alt) and click on a starting point 

that makes sense to you—I chose the upper-left corner of the 

first letter. Notice the X and Y coordinates under Offset in the 

Clone Source panel show 0, 0 when you first click. We’ll come 

back to that soon.

Step Six: Click back to the target document and make sure the 

top blank layer you created earlier is active. Choose the Words 

sample in the Clone Source panel, choose Current Layer in the 

Options Bar, and make a random paint stroke anywhere. The 

point you sampled shows up right where you paint. Now undo 

the stroke with Command-Z (PC: Ctrl-Z). Notice the X and Y 
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Step Nine

Step Eight

coordinates aren’t 0, 0? Go ahead and enter zeroes into both of 

those boxes manually. This forces your painting sample to show 

up in the same place as your source document so long as the 

source and target are the same size. This is a bit of a cheat, but 

it’s fast and easy to remember. Continue painting a little to make 

the words show up here and there, but not completely. The 

Drop Shadow layer style doesn’t show up when Current Layer 

is selected because the layer effect is considered live unless you 

rasterize the layer and make the layer style permanent.

Step Seven: Now choose Current & Below in the Options Bar and 

paint a little more. You’ll see not only the Portrait layer where you 

paint, but the text complete with Drop Shadow shows up, too.

Step Eight: Let’s try out the Portrait sample next by clicking on its 

Clone Source icon in the Clone Source panel, and setting its option 

to Current Layer. You’ll have to do the same trick with making a 

single paint stroke, deleting it, and setting X and Y to zero to align 

the samples. Fortunately, you only have to do this once for each 

sample you want aligned, but every time you create a new sample.

Step Nine: As you paint this time, you’ll only be using the Portrait 

layer, which means you could potentially paint over your text. 

This looks a little like masking, but is destructive. The advantage, 

however, is that you can easily go back and choose the Words 

sample in the Clone Source panel to fill in some of the text; just 

be sure to change its option back to Current Layer. Keep in mind 

that when you’re cloning the Portrait layer you haven’t turned off 

the Words layer in the source document—you’re just ignoring it 

by sampling from beneath it in the layers stack.

Step Ten: There’s really no limit to how you can use this tech-

nique, especially when you combine it with other tricks you prob-

ably already know. As always, I want to leave you with some 

things to experiment with on your own. In the finished image, 

I changed the Words layer blend mode in the source document 

to Divide, changed the option to Current & Below for the Word 

Clone Source, and painted over selected words in the target 

document to highlight them in a different color.

While this same look can be achieved using masks, the method 

of creation is much different. When I started this example, I had 

no idea what I wanted the final image to look like, so I just played 

with it. Using this setup was much more organic and let me 

explore different looks quickly without having to deal with con-

fusing elements and blending several layers. Besides, it’s always 

good to have more than one technique to work with! In a future 

article, I’ll show you how to use this same technique with portrait 

retouching to speed up your work and put that much more pol-

ish on your art. ■

http://kelbyone.com/books/
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Photoshop CC has a scripted pattern fill called Tree that allows you to parametrically grow a wide variety of plant 
species and even control the direction of illumination on their leaves. We’ll also show you how to manually project 
tree shadows for added realism.

Beyond Photoshop
 adding trees and projecting shadows 

SCOTT ONSTOTT

Step Two

Step Six

Step Seven

Step Nine

Step Five

Step Three

Step Ten

Step One: Open an image to which you would like to add a tree. 

Create a new layer by pressing Shift-Command-N (PC: Shift-Ctrl-N).  

Type “Tree” as the name and click OK in the New Layer dialog.

Step Two: Choose Edit>Fill. Select Pattern in the Use drop-down 

menu, check Scripted Patterns, and select Tree from the Script 

drop-down menu. The pattern selected in the top section of this 

dialog doesn’t matter as it will be replaced by a scripted tree pat-

tern instead. Click OK.

Step Three: In the Tree dialog, open the Tree Type drop-down 

menu and see that there are 22 different tree species available. 

What an amazing variety for a script! Select 19: Fraxinus Griffithii, 

set Light Direction to 44, Camera Tilt to 1, Leaves Amount to 66, 

and Arrangement to 42.6. The icon in the bottom right of the 

preview window gives you a feeling for where the sun is in rela-

tion to the tree. Camera Tilt allows you to simulate being some-

what above the tree, but in this scene we’re looking at it more 

or less in elevation, so a value of 1 works well. Take a look at the 

shadows in the photo and see that we’re attempting to match 

the direction of the sun’s illumination in the photo with Light 

Direction equal to 44. The Arrangement slider is used to random-

ize the tree’s structure. Experiment with these settings based on 

the photo that you’re working with, and click OK. 

Step Four: Right-click the Tree layer and choose Convert to 

Smart Object. Press Command-T (PC: Ctrl-T) to Free Transform 

the tree. Click the Maintain Aspect Ratio icon (chain link) in the 

Options Bar to maintain the aspect ratio and type a percent-

age in the Width box to resize the tree to fit your photo (50%  

in our example). Drag the tree into position, and click the Com-

mit Transform icon (checkmark) in the Options Bar to complete 

the transformation.

Step Five: Select the Ellipse Tool (nested under the Rectangle 

tool [U] in the Toolbox), and set its Fill in the Options Bar to a 

dark-brown color such as #543b1d. Drag out a wide, low ellipse 

to simulate a hole in the sidewalk or ground that the tree is 

planted in. Press Command-[ (PC: Ctrl-[) to move the Ellipse layer 

below Tree layer so that the tree trunk shows on top.

Step Six: Select layer Tree and press Command-J (PC: Ctrl-J) to 

duplicate it. Click the Hue/Saturation icon in the Adjustments 

panel (first icon in the second row). Drag the Lightness slider all 

the way to the left in the Properties panel to make this a shadow. 

Click the leftmost icon on the bottom of the Properties panel so 

that the adjustment clips to the layer below.

Step Seven: Shift-click the Tree copy layer so that the top two lay-

ers are selected and press Command-E (PC: Ctrl-E) to merge them. 

Double-click this layer’s name, and rename it “Shadow.” Press 

Command-T (PC: Ctrl-T) to transform, hold Shift, and drag outside 

the object to rotate the tree’s shadow 90° clockwise. Right-click 

and choose Distort from the shortcut menu. Drag the top-center 

handle down so that the shadow compresses vertically. Move the 

shadow over to the right so that its trunk matches up with the tree 

trunk, and press Enter to commit the transformation.

Step Eight: Decrease the Opacity of the Shadow layer to match 

the tree’s shadow to the other shadows in the scene—a value of 

60% suits our purpose. In the real world, shadows blur the far-

ther they’re away from the objects casting them. We’ll simulate 

this by adding a gradient mask to the Shadow layer so that the 

shadow fades along the height of the tree as it’s projected on 

the sidewalk.

Step Nine: Click the Add a Layer Mask icon (circle in a square) 

at the bottom of the Layers panel. Select the Gradient tool (G) 

and choose the Foreground to Transparent preset in the Gradi-

ent Picker in the Options Bar. Press D to set the default colors and 

X to swap them so that black is in the Foreground color. Drag a 

gradient from the right end of the shadow to the left where it 

meets the “real” tree trunk. The shadow fades away as the tree 

gets farther away from the ellipse.

Step Ten: Let’s add another tree, but this time we’ll only add its 

shadow to suggest that there’s another tree just out of the frame 

on the left. Repeat Steps One through Nine but this time drag 

the Arrangement slider to another value so that this tree looks 

different than the first tree. Drag the shadow of the new tree to 

the left edge of the frame to add the visual cue that there are 

other trees in the image, which makes this mini-mall that much 

more attractive.

It’s amazing how easy it is to add trees and shrubs to photos 

with the scripted Tree pattern fill. Manually projecting shad-

ows of scripted trees is well worth the effort to give them some 

added realism. ■
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Product Reviews

Clean out Your Duplicate Images 
Review by Erik Vlietinck

Black-and-White Photo Editor for Mac 
 Review by Erik Vlietinck

 Tonality Pro

PhotoSweeper works with Aperture, iPhoto, and Adobe Light-

room libraries and image folders to find duplicates and look-alikes 

based on time interval or by comparing histograms or pixels. 

You start the process by having the app create a catalog of 

your images—I used my collection of more than 6,500. (Note 

that you can save the catalog for later use.) After cataloging, 

decide which algorithm you want to use. Duplicates will find 

only exact duplicates on a byte-per-byte basis. Other methods, 

which resemble more or less the way you’d compare your pho-

tos, introduce some form of fuzziness.

I decided to go with the default setting, which is Time + Bit-

map, where the interval between photos is taken into account, 

in addition to a visual similarity. If you want, you can change the 

bitmap size, the interval, RGB sensitivity, and other parameters to 

fine-tune the process, but the default settings gave me excellent 

results. When you’re finished with the settings, click the Com-

pare button. It took less than 10 minutes to compare my 6,500+  

photos (using an iMac mid-2011 i5/16 GB). 

After comparing the photos, PhotoSweeper marks the 

images it has identified as duplicates or look-alikes. You can then  

Tonality Pro is a black-and-white photo editor that can be used as 

a standalone application or a plug-in to Adobe Lightroom, Photo-

shop, or Apple Aperture. Tonality has a histogram with a 10-zone 

system strip, the familiar Macphun tools for selective editing, and 

a large selection of presets.

Tonality pro features the usual tools, such as tone adjustments, 

color filters, a tone curve, and vignette, as well as structure, glow, 

lens blur, texture overlay, grain, and photo frames effects. I first 

tested Tonality to see if the presets were any good. I found the Film 

Emulation category the least attractive, with only some 20 films 

from which to choose, but overall the presets offer a balanced set 

of creative starting points. 

The real fun comes from experimenting with the parameters. 

Without ever looking at the online user guides, I could create 

black-and-white images that were tuned exactly to my liking. 

What’s more, I discovered you can selectively bring back a color. 

For example, in a photo of a housing block with a bright red traffic 

plate, I wanted to get the plate’s red back. All I needed to do was 

look at those images (grouped together in what the app thinks 

are a series of look-alikes) in the large thumbnail view, where 

you can uncheck any, if necessary. In my test, PhotoSweeper 

interpreted what “look-alike” means correctly about 95% of  

the time. 

When you’re finished going through all the marked and 

unmarked images, and making any changes, you can still restore 

them (in case you removed any accidentally) by clicking on the 

Trash icon to see which photos will be thrown out the window. ■

crank up the red saturation, add a separate layer to block out the 

red brickwork from the houses, and I was done.

There were a couple filters that I had my doubts about. The glow 

effect could do with a few more configuration options, and the 

grain option isn’t realistic enough, as it has no relation to film. With 

some slider settings, it looked more like I was adding dirt than grain.

With the opacity of each layer adjustable from not to fully 

effective—along with the presets, masking tools, and effects 

available in Tonality Pro—your creative options are virtually end-

less. [For a tutorial on using Tonality Pro, see “Maximum Work-

flow” on page 104.—Ed.]  ■

 PhotoSweeper

Company: Gwinno Software Inc.	 Price: $9.99

Web: http://photosweeper.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Simplicity; accurate pattern-recognition algorithm; fine-tuning

	 Not: 

Company: Macphun Software	 Price: $69.99

Web: www.macphun.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Selective color; layers; nice selection of presets 

	 Not: Too few film presets; grain not realistic

Company: Koninklijke Philips N.V.	 Price: $899.99

Web: www.usa.philips.com	 Rating: ◆ ◆

	 Hot: Features; multiple ports for USB and video; ease of use

	 Not: Sluggish performance; poor text clarity; speaker sound; webcam

Professional LCD Display with Webcam and MultiView
Review by Daniel M. East

Create Your Own 3D LUTs in Photoshop
Review by Erik Vlietinck

 Look Converter

Finding that perfect balance of quality, size, and price for a display 

can require jumping over a few hurdles, and although pricing has 

come down for some brands, it’s still an all-or-nothing pursuit. 

The Philips Brilliance 272P4 LCD Monitor enters the race dressed 

up with a lot of impressive features that add value to the product, 

but the question of quality remains.

The 272P4 offers a lot of ports, and you can connect to the 

monitor with most video-connector cables, but not all are included 

in the box. For example, while there are two HDMI inputs and 

outputs, you’d need to add an HDMI-to-Thunderbolt cable for use 

with a more recent laptop. The 272P4 has MultiView capability 

for dual-computer connections simultaneously, and it also offers 

Multi Stream Transport (MST) Display Port technology if you have 

a DP1.2 graphics card with MST option. Like many newer displays, 

the 272P4 operates in landscape and portrait modes but, unfor-

tunately, the display barely clears the base of the stand (even at its 

highest point), which makes it easy to scrape the base.

Although Philips includes quite a few extra features on the Bril-

liance 272P4, the quality suffers for it. The built-in stereo speakers 

Picture Instruments recently released Look Converter to convert 

presets and looks from any image editor into 3D LUTs (lookup 

tables) so that you can use these looks in any application that sup-

ports 3D LUTs. You can use photos and footage to create your LUTs 

using a simple workflow that exports to the two file formats that 

Adobe Photoshop and most nonlinear editing systems can use.

Look Converter generates a JPEG, a neatly organized image 

of color patches that Look Converter calls the Neutral Filter. You 

use this intermediary file to create your adjustments. Say you 

want to use a particular look in Photoshop CS6 that you created 

from adjusting overall contrast, saturation, brightness, etc. in DxO 

Optics Pro, here’s what you do: 

• �Open an image in DxO Optics Pro and apply your adjustments, 

then save the adjustments to a new preset. 

• �Open the Neutral Filter in DxO Optics Pro and apply the new pre-

set, then save the Neutral Filter to new-filter.jpg (for example).

• �Load the new-filter.jpg file in Look Converter, and click the  

3D LUT button.

• �Now, all you do is create a Color Lookup adjustment layer  

in Photoshop and load the 3D LUT you’ve just created. 

distort and offer very poor sound quality—even for voice repro-

duction—and the webcam image quality is poor, regardless of 

how much light is at your desk. As for actual image quality in 

video, the response seems a bit sluggish with some visible arti-

facts, and text tends to have some ghosting on both a MacBook 

Pro and a Mac Pro with an NVIDIA GTX 680 graphics card. In spite 

of all of its features, the Philips Brilliance 272P4 doesn’t quite get 

over the hurdles in the race for display superiority. ■

Everything works as long as you can load the Neutral Filter JPEG 

into the program from where you want to grab your settings. 

Look Converter also supports batch processing and exports to 

two 3D LUT formats, either of which is used by Adobe Final Cut 

Pro X, Apple Premiere Pro, DaVinci Resolve, etc. Its algorithm gen-

erates the smallest allowable cube size for accurate results, as the 

maximum 256x256x256 size would require too much GPU power 

and memory to work well. ■

 Philips Brilliance 272P4 Monitor

Company: Picture Instruments UG	 Price: $25 

Web: www.picture-instruments.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Ease of use; creates two formats; inexpensive

	 Not: 
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R E V I E W S  ›  ›

Skin Retouching for Video
 Review by Erik Vlietinck

Organize Your Photography Business 
Review by Michael Corsentino

High-End Compact Flash Unit
 Review by Michael Corsentino

High-Performance Enterprise RAID Storage Solution 
Review by Daniel M. East

 Portraiture Video Plug-in
 kumu STUDIO

Photographers often retouch portraits for skin blemishes, and you 

can do the same when editing a video. The algorithm to make skin 

smoother and improve its looks is the same, but to accommodate 

a moving subject, you must have the means to follow the subject’s 

face as it moves across the frames.

I tested the Portraiture Video Plug-in for Apple Final Cut Pro X, 

although it’s also available for many other nonlinear editors (NLEs), 

including Adobe Premiere Pro, After Effects, Sony Vegas Pro, and 

Da Vinci Resolve (now in beta).

Portraiture offers two basic enhancements: smoothing and tint/

warmth adjustments. To create a mask that applies only to a face, 

you allow the plug-in to first calculate the mask automatically. Dur-

ing testing, the calculation was blazingly fast, but it consistently cre-

ated a mask that was either too big or too small for the purpose. 

Although you can adjust the mask yourself, you’ll have a hard time 

making it work perfectly if skinlike colors appear in the background. 

I was only able to obtain a clean mask against a uniform back-

ground that lacked skinlike colors. If the mask isn’t perfect, you’ll 

Fledgling professional photographers quickly realize that running 

a successful photography business is about a lot more than just 

making great pictures. Managing relationships, having a firm grasp 

of financials, and keeping track of workflow are all equally impor-

tant. Even seasoned pros can find the current crop of feature-laden 

studio-management packages are not only pricey and more than 

they need, but also require a considerable investment of time to 

learn. In fact, many end up overwhelmed and use nothing at all 

to stay on top of their businesses. This is far from ideal. 

Enter kumu STUDIO, veteran wedding photographer and edu-

cator Kevin Kubota’s new, easy-to-use, and affordable studio-

management software. Designed by a photographer for photog-

raphers, kumu STUDIO is based on the workflow solutions and 

best practices developed and fine-tuned over Kevin’s many years 

running a highly successful photography business. Ideal for stu-

dios from one to four people, kumu STUDIO focuses on getting 

your business organized, managing workflow and relationships, 

helping you market, generating invoices, and developing a clear 

understanding of the cost of goods and retail pricing. 

Look out mono strobe lovers, there’s a new sheriff in town and 

its name is ELC, short for Elinchrom Compact. Elinchrom’s ELC 

Pro HD 500 and 1000 Ws mono heads are the new product 

to beat. Elinchrom President Chris Whittle put it best when 

he explained, “We set out to make a unit that would not only 

change the way a photographer works but also the way they 

think. We believe the ELC combines everything a photographer 

needs with everything a photographer wants, plus the consis-

tency and reliability that you expect from Elinchrom.”

What is it exactly that makes the new ELC Pro HD heads so 

compelling? Begin with three exciting new shooting modes that 

will change the way you work: Sequence Mode allows sequen-

tial triggering of up to 20 ELCs in bursts or continuous cycle to 

keep pace with current high-frame-rate cameras; Delayed Mode 

makes possible first or second curtain sync and everything in-

between; and Strobo Mode enables images with stroboscopic 

effects in a single frame. This last one is supercool!

The ELC’s new charge circuit delivers lightning-fast recycle 

times to full power (0.6 sec for the ELC 500, and 1.2 sec for 

the ELC 1000), and easy use on location with battery-powered 

There are a lot of external storage solutions with many different 

configurations available today. Depending on your specific needs, 

it’s no longer just about size and speed, but about connections 

and compatibility. For most photo and design pros, the combina-

tion of all of these elements is important, but reliability is the must-

have for today’s digital world. As G-Technology has long been 

known for their excellent products and the most current connec-

tivity, their new G-RAID with Removable Drives high-performance 

line with Enterprise-grade drives may be the balance you need of 

both space and speed for a wide range of systems.

While this version of the G-RAID doesn’t offer a Thunderbolt 2  

connection, G-Technology does have models that offer it. In this 

case, the model tested had just about everything else, making 

it more compatible for more end users. In other words, if your 

computer meets the system requirements, but isn’t the latest 

model, you can enjoy the fast transfer speeds with larger video 

and graphics files. The G-RAID includes eSATA, USB 3 (USB 2 

compatible), and FireWire 800 connectivity, but your operating 

system must be Mac OS X 10.7 or later. Windows users must 

be using Windows 8.1, or 8 and 7, which requires reformatting 

before use.

end up with a glamour glow that bleeds through in the back-

ground when the subject’s head moves even slightly. 

Because you can’t block the mask with a secondary key, or cre-

ate a tracking path that firmly defines facial contours, you can’t 

achieve a perfect result against backgrounds with skinlike tints. 

Some award-winning plug-ins have already demonstrated that 

this can be done. As it is now, the Portraiture Video Plug-in looks 

to me like a photo plug-in that was ported too quickly to make it 

work in NLEs. ■

In-house development and user-encouraged feedback mean 

fast-paced updates delivered right to your desktop. Easily gener-

ate financial reports, export files to accounting applications, create 

client lists based on user-defined search criteria for use with email 

programs and email blast services, and link directly to your Light-

room catalogs via kumu STUDIO. It’s time to get down to business. 

Let kumu STUDIO management software show you the way. ■

inverters and generators. New capacitor power control makes 

possible not only accurate color across the entire power range, 

but also superfast, action-stopping flash durations up to 1/5000 

for the ELC 500, and 1/5260 for the ELC 1000.

At the end of the day what matters most is being able to 

be creative without being technically overwhelmed. Elinchrom’s 

ELC Pro HD heads deliver the goods with a feature-rich, easy-to-

use OLED driven contextual menu system that opens the door 

to new creative possibilities for photographers everywhere. ■

The 8-TB (model tested) drive has minimal fan noise, read-

ing just under 35 decibels at approximately 4' away. The cables 

are long enough for placement on the floor or at enough of a 

distance to make the drive nearly silent. Given its competition, 

the G-RAID has a higher price than some similar drives, but its 

Enterprise drives, up to 300 MB/s access times, and the addi-

tional connection ports set it apart from the rest. If you need 

big storage with serious speed, but without Thunderbolt, the 

G-RAID with Removable Drives storage solution is an outstand-

ing choice. ■

 �Elinchrom ELC Pro HD G-RAID with Removable Drives

Company: Elinchrom	 Price: ELC 500: $1,049.99; ELC 1000: $1,449.99

Web: www.elinchrom.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Feature rich; easy to use; tons of options

	 Not: No battery power

Company: G-Technology	 Price: �4 TB: $449.95; 8 TB: $749.95; 
12 TB: $1,199.95

Web: www.g-technology.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Quiet; fast; connection options; removable storage

	 Not: Price; no support for Windows XP or older systems

Company: Imagenomic, LLC	 Price: $99/year 

Web: http://imagenomic.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Easy to use

	 Not: No tracking capabilities; expensive

E
rik
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Company: Kubota Image Tools	 Price: �$15/Month; $10/Month with 
an annual subscription

Web: www.kubotaimagetools.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Simple to use; features you need; 15-day free trial

	 Not: Not cloud based; no built-in calendar

www.elinchrom.com
www.g-technology.com
http://imagenomic.com
www.kubotaimagetools.com


› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 n
o

v
e

m
b

e
r

 2
0

14

128

› 
› 

k
e

l
b

y
o

n
e

.c
o

m

129

R E V I E W S  ›  › B O O K  R E V I E W S  P E T E R  B A U E R  ›  ›

This publication is both an exploration of shape, color, and 

light and a how-to book. The first section discusses the art 

of creative thinking, and not just from an existential perspec-

tive—there are lots of little tips that you can use to help refine 

your own creative thinking. The middle part of the book fea-

tures fabulous photos and some pages describing the creative 

process, control over the image capture, and some general 

thoughts on image manipulation. The final section discusses 

using Photoshop and Camera Raw to adjust the RAW image 

to match what your mind’s eye saw. Like the first edition 

(2006), each of the 200+ photos was taken from the air on the 

author’s many, many business trips. (This eBook has 128 pages, 

but many of them are actually two-page spreads, so the page 

count is actually substantially higher.) 

First, the good news: This beautiful book is sold by major 

retailers closer to $50 than the list price of nearly $90. Nook, 

Kindle, and iBook versions are around $30. I recommend the 

hardcover to best view the photos—and perhaps leave on the 

coffee table for others to enjoy. This semi-autobiographical 

book includes hundreds of full-page glossy photos, including 

more than 200 portraits of celebrities and other images made 

by the author. Embossed into the back cover is this quote: “I 

now find peace in the realization that millions of potential 

masterpieces happen each moment the world over and go 

unphotographed.” But before that back cover are hundreds 

of masterpieces that did get photographed. In addition to the 

author’s masterful photos, there are almost 100 images by 

others that inspired or impressed the author. Put it on your 

wish list!

Road to SeeingWindow Seat: The Art of Digital Photography  
and Creative Thinking By Dan Winters
By Julieanne Kost

          

Publisher: Self-published	 Pages: 128 pages (eBook)

Website: iBooks

	 Price:  $4.99		  Rating:  ◆ ◆ ◆ ◆ ◆

Publisher: New Riders	 Pages: 684

Website: www.newriders.com

	 Price: $89.99	 Rating:  ◆ ◆ ◆ ◆ ◆

Printing on Large-Format Printers Made Easy  
 Review by Erik Vlietinck

Create Realistic and Abstract Filters and Effects 
Review by Bruce Bicknell

 PrinTao 8

Aimed at professional photographers and graphic designers, 

PrinTao 8 from LaserSoft Imaging is a new, Mac-only tool that’s 

fine-tuned for optimized printing with a specific class of printers, 

and it can also save you paper and ink. The software exploits all the 

capabilities of the native printer driver, so when you use PrinTao 8, 

you don’t have to first learn about RIPs, CMYK-to-RGB conversions, 

and other tasks that typically belong to PostScript/PDF printing.

To start, select your printer model, supported media, desired 

print quality, roll or cut sheet, and media size. When finished 

making your selections, you’re taken to the work area with its 

media browser, main window, and tools sidebar. Here’s where 

you’ll select your images from the media browser or drag them 

from the Finder.

Templates come in multiple flavors. The Freeform template 

allows you to position the images the way you want. Other tem-

plates optimize media usage by calculating optimum size, place-

ment, and rotation to fit all the images into as small a space as 

possible. There’s also a template to match cut and roll sheets, and 

an interactive cutter allows you to decide where to cut a roll. Cut-

ting can be at predefined locations, too.

The long-awaited fourth version of Filter Forge is now available 

and loaded with new features that make it better than ever. For 

those who aren’t familiar with the product, Filter Forge is a plug-in 

for Photoshop that allows you to create your own filters without 

programming them. There’s also a free online library of more than 

10,000 user-created filters. On top of that, Filter Forge is more 

robust with the flexible filter manager, support for component 

grouping and loop operations, fantastic filters, and much more. 

The new filter manager helps organize, manage, and back up 

user-created filters. The single My Filters location for user-made 

filters has evolved into multiple filter storages that are mapped to 

physical folders on disk. It also adds multiple user-defined Favor-

ites folders, and a revamped filter search list.

With the new Groups component, the user is able to easily cre-

ate complex filters by packaging the reusable parts of the filter tree 

into custom components with definable inputs and parameters.

For those of you who are not into writing code (like me), Filter 

Forge has you covered with the Loop component. The Loop com-

ponent brings nested loops and recursions (two key concepts of 

You can edit images in various ways, which means you 

always have visual feedback for print quality and image position 

on the paper. 

PrinTao 8 supports only a limited number of large-format 

Epson and Canon printers, the smallest of which is the Epson 

Stylus Photo R2880. Depending on printer class and maximum 

media size, prices range from $99 for the Home Edition to $699 

for the 64" Edition. 

PrinTao 8 is continuously being updated and its rather poor 

metadata support should be improved by the time you’re read-

ing this. ■

programming) into the visual environment and lets you render the 

results into a single image.

With the new features and endless possibilities, Filter Forge 4 

is well worth the investment if you’re looking for more creativity 

in your work. With more than 10,000 filters in the online library, 

you’re sure to find what you need but, if you can’t, then create 

your own and share it with the world. There’s a 30-day trial, and 

it’s also available in Basic and Standard editions, as well as a sub-

scription with quarterly payments for the Professional edition. ■

 Filter Forge 4 Professional

Company: Filter Forge	 Price: $399 

Web: www.filterforge.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Tons of filters and effects; ability to create your own

	 Not: 

Company: LaserSoft Imaging AG	 Price: From $99

Web: www.printao8.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: User-friendly; features; optimization algorithms

	 Not: Poor metadata support

www.newriders.com
www.filterforge.com
www.printao8.com
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Welcome to the latest installment of “Photoshop Tips.” Once 

again, this column is loaded with tips that will save you time and 

relieve frustration. Huh? Frustration? Yes, you’re going to kick 

yourself for doing some things the hard way for so long. So, in 

the spirit of breaking bad habits, here are some new habits for 

you to incorporate into your Photoshop life. 

Drag the Histogram
When you’re editing images in Camera Raw, I’m sure you’ve 

seen the histogram in the top-right corner. While it’s pretty to 

look at, it also has some functionality. You can actually click on 

the histogram and drag to adjust your image. It’s broken up into 

five zones: Blacks, Shadows, Exposure, Highlights, and Whites. 

As you drag a zone, the tones in that region will be adjusted 

while leaving the rest alone. It’s like all the Basic panel tone slid-

ers in one!

Files to Layers
Have you ever wanted to take a whole lot of files and load 

them into a single document with a new layer for each file? If 

you’ve been using Photoshop for any amount of time, I’m sure 

you’ve come across this need more than once. You could open 

all the images and then drag them into a single document win-

dow. Yes, that will get the job done; however, there’s a much 

faster way to do it. Choose File>Scripts>Load 

Files into Stack. Select the images or folder 

of images and Photoshop will now do all the 

heavy lifting for you. 

Nondestructive Healing
When doing retouching, there are few tools 

more useful than the Healing Brush tool. This is 

ideal for getting rid of blemishes and wrinkles. 

Here’s a better way of using it: Option-click 

the Create a New Layer icon, name the new 

layer something like “healing,” and click OK. 

Make that layer active and choose the Heal-

ing Brush tool (nested under the Spot Healing 

Brush tool [J] in the Toolbox). In the Options 

Bar at the top, choose either Current & Below 

or All Layers from the Sample drop-down menu. Now when 

you’re healing and repairing blemishes, the healing will appear 

on this blank layer. Because it’s nondestructive, you now have 

two advantages. First, if you change your mind, you can erase or 

mask out the adjustments. Second, and this is great for wrinkle 

work, you can reduce the Opacity in the Layers panel and make 

the retouching more subtle and realistic looking. Remember, 

a photo that doesn’t look retouched is the perfect retouch. As 

soon as it’s noticeable, it’s bad, kind of like plastic surgery. 

Making a Better Bevel
When creating a Bevel & Emboss layer style, I have a tip for you 

that will make your bevels look a lot better. Choose the Contour 

option (not to be mistaken for Gloss Contour) that appears just 

below Bevel & Emboss in the list of Styles on the left of the Layer 

Style dialog. When you choose this option, it will add a touch 

of professionalism to all your bevels. Don’t forget to turn on the 

anti-aliasing in both the Contour and in the Bevel & Emboss styles. 

Stealing Style Sheets
Did you know that you could share your paragraph and character 

style sheets by sharing a PSD file? All you need to do is create a 

PSD, define and save some styles, and then save the PSD. In this 

example, we’ll do the paragraph styles (it’s the same for char-

acter styles). In an open document, go to the Paragraph Styles 

panel (Window>Paragraph Styles), and click the Create New 

Paragraph Style icon at the bottom of the panel. Double-click the 

new style that appears, make some changes in the Paragraph 

Style Options dialog, and click OK. Save and close the document. 

To get the styles out of the PSD, open another document, go to 

the Paragraph Styles panel again, click on the top-right corner, 

and choose Load Paragraph Styles. Find your 

PSD and then click Open. Rather than open the 

PSD, it will load the styles into the Paragraph 

Styles panel. This is useful when you have a 

document in progress and you want to use the 

same styles that were used for another PSD. It 

also works great when you’re in a collaborative 

workflow with someone else. 

Lasso Tool, 2 in 1
The Lasso tool (L) is great for making quick 

selections around different areas. It comes in 

two flavors: the regular freehand Lasso tool and 

the Polygonal Lasso tool. The Polygonal Lasso is 

used for making straight line selections. How 

many times have you started in one tool and then wanted to 

finish the job in the other one? You can actually toggle between 

the two while drawing. How so? While using the Lasso tool, hold 

down the Option (PC: Alt) key, release the mouse button, and 

click around your document to add straight selections with the 

Polygonal Lasso tool. When you’re ready to switch back to the 

Lasso tool, click-and-hold the mouse button, release the Option 

(PC: Alt) key, and begin dragging again.

Free Add-Ons and Templates
There was a not-so-well publicized update to Creative Cloud that 

gives you tons of free assets. In the Adobe Creative Cloud app, 

choose Assets in the navigation near the top. Then, on the next 

line down, choose Market. Now you can find tons of things like 

book and poster templates, mock-ups, icons, brushes, and more. 

These are super useful to get a jumpstart on a design, or base an 

entire new design around them. It’s definitely worth a browse to 

see what’s there. 

Better Color in Blend Modes
There are a number of different layer styles that can be used 

for various things. One interesting style is Color Overlay. Typi-

cally when you apply this style, it just fills the pixels with a solid 

color. That doesn’t seem very useful because it negates a lot of 

the other work you may have done to an image. Here’s a tip for 

using Color Overlay: Change its Blend Mode to Color in the Layer 

Style dialog. When you do this, it will now only change the color, 

leaving the other details (luminosity) intact. You could also click 

the button that says Make Default for it to remember this setting.

Double-Screen Workspace
I’m sure that you’re aware that you can create custom work-

spaces that remember your panel setups. For the three of you 

who didn’t know that, this is a double tip. Something you might 

not be aware of is that the panel layouts are remembered, even 

on two monitors. So you can set up all your panels on the sec-

ond monitor and position them exactly as you like, then click the 

top-right drop-down menu in the Options Bar that has all the 

workspaces, and choose New Workspace. Now whenever you 

toggle to that saved workspace, you’ll have your panels spread 

out across two monitors all ready for you.

Doing the Math, or not Doing the Math
You know something that’s really frustrating sometimes? When 

you want to divide a document evenly for a determined number 

of objects. You know, like into thirds or quarters. You figure out 

the size, then you do the math, which can get really confusing 

when dealing with multiples of inches (and you thought metric 

was hard). Here’s a little trick that will make life so much easier. 

Press Command-R (PC: Ctrl-R) to open the rulers. Okay, that 

didn’t help much; you still have hard math to do. Here’s the tip: 

Right-click on one of the rulers and choose Percent. Yep, you 

can now divide things based on percentage and not all the weird 

inches and fractions thereof. ■
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To: Tommy
From: KelbyOne Help Desk

Contours are available for Inner Shadow, Inner Glow, 

Satin, Outer Glow, Drop Shadow, and Bevel & Emboss 

layer styles. The triangle to the right of the default Con-

tour thumbnail in the Layer Style dialog opens a menu of 

preset contours from which to choose. Each changes the 

way a specific effect is shaped as it moves away from the 

edge of the visible pixels on the selected layer.

You can also apply a layer style to a layer group. The 

style is added to the group as a whole, not to the content 

of the individual layers within the group. If, for example, 

the content of two layers overlap and you apply a Drop 

Shadow effect, the shadow will not overlay the content 

of layers below the top layer.

For all of the styles that offer Contour except the 

Satin effect, the default is Linear. The effect gradually 

and evenly fades from 100% visible to 0% visible. Each 

of the options in the Contour Picker changes how the 

effect is applied as it moves from the edge of the visible 

pixels. If the pixels on the layer or shape include empty 

areas (such as a hollow circle), the effects are applied 

within as well as outside the shape. The best way to see 

how contours work is to play with them.

[KelbyOne members may download a practice file for 

this tutorial at http://kelbyone.com/magazine/issue/

november-2014. All files are for personal use only.]

If you want to create your own sample file for testing, 

follow these steps: Create a new document, perhaps 

1000x800 pixels (resolution is insignificant). Set the Fore-

ground color to bright yellow (R:255, G:255, B:0). Select 

the Rectangle tool from among the Shape tools (U). 

From The Help Desk 
	

›  ›

The KelbyOne Member  
	 HELP DESKS 

Are you taking advantage of the Help Desks at the KelbyOne member website? This is the place where you can get all of your 

Photoshop and Lightroom questions answered either by other KelbyOne members or by our Help Desk experts. Not only that, you 

can get photo and computer gear help and advice, as well. What are you waiting for? Visit the Community section on the 

KelbyOne member site today! ■

In the Options Bar, make sure that the tool is set to 

create a Shape rather than a Path or Pixels. Hold down 

the Shift key and drag a square about 200 pixels per 

side. Select the Ellipse tool from the Shape tools, hold 

down the Shift key, and drag to add a circle approxi-

mately 200 pixels in diameter. Switch to the Custom 

Shape tool, click the downward-pointing triangle to the 

right of the Shape thumbnail in the Options Bar to open 

the Custom Shape Picker, select the Circle Thin Frame 

shape (hollow circle), and Shift-drag to create a circle 

about 200 pixels in diameter. Add several additional 

shapes of your choice.

If any of your shapes are on a separate layer in the 

Layers panel, click on the top layer, hold down the Shift 

key, and click on the bottom shape layer (not the Back-

ground layer), then use the Layers panel flyout menu 

command New Group from Layers. In the Layers panel, 

make sure the group is selected rather than a layer.

Starting with the Bevel & Emboss layer effect, 

increase the Size significantly to make the changes to 

the contour more visible (20 pixels is a good choice for 

shapes of these dimensions). Click the triangle to the 

right of the Contour thumbnail and experiment with 

each of the preset contours. Repeat for each of the 

additional contour-using layer effects, one at a time 

and in combination.

You can also click directly on the Contour thumbnail 

in the Layer Style dialog to open the Contour Editor and 

create your own custom contours. (Don’t forget to save 

the ones you think you’ll use in the future.) ■   

In several of the panels of the Layer Style dialog there’s an option named Contour. What is it and 
how do I use it?—Tommy
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